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Plain text   

End a line with two spaces  
to start a new paragraph.   

*italics* and _italics_

**bold** and __bold__

superscript^2^

~~strikethrough~~

[link](www.rstudio.com)

# Header 1

## Header 2

### Header 3

#### Header 4

##### Header 5

###### Header 6

endash: --

emdash: ---

ellipsis: ...

inline equation: $A = \pi*r^{2}$

image: ![](path/to/smallorb.png)

horizontal rule (or slide break):

***

> block quote

* unordered list
* item 2

+ sub-item 1
+ sub-item 2

1. ordered list
2. item 2

+ sub-item 1
+ sub-item 2

Table Header  | Second Header 
------------- | ------------- 
Table Cell    | Cell 2
Cell 3        | Cell 4

Syntax Becomes
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Syntax Becomes

Make a code chunk with three back ticks followed 
by an r in braces. End the chunk with three back 
ticks: 

```{r} 
paste("Hello", "World!") 
``` 

Place code inline with a single back ticks. The 
first back tick must be followed by an R, like 
this `r paste("Hello", "World!")`.

Chunk options

Add chunk options within braces. For example, 
`echo=FALSE` will prevent source code from being 
displayed: 

```{r eval=TRUE, echo=FALSE} 
paste("Hello", "World!") 
``` 

option default value description
Code evaluation

child NULL A character vector of filenames. Knitr will knit the files and place them into the main document.

code NULL Set to R code. Knitr will replace the code in the chunk with the code in the code option.

engine 'R' Knitr will evaluate the chunk in the named language, e.g. engine = 'python'. Run names(knitr::knit_engines$get()) to 
see supported languages.

eval TRUE If FALSE, knitr will not run the code in the code chunk.

include TRUE If FALSE, knitr will run the chunk but not include the chunk in the final document.

purl TRUE If FALSE, knitr will not include the chunk when running purl() to extract the source code.

Results
collapse FALSE If TRUE, knitr will collapse all the source and output blocks created by the chunk into a single block.

echo TRUE If FALSE, knitr will not display the code in the code chunk above it’s results in the final document.

results 'markup'
If 'hide', knitr will not display the code’s results in the final document. If 'hold', knitr will delay displaying all output 

pieces until the end of the chunk. If 'asis', knitr will pass through results without reformatting them (useful if results 
return raw HTML, etc.)

error TRUE If FALSE, knitr will not display any error messages generated by the code.

message TRUE If FALSE, knitr will not display any messages generated by the code.

warning TRUE If FALSE, knitr will not display any warning messages generated by the code.

Code Decoration
comment '##' A character string. Knitr will append the string to the start of each line of results in the final document.

highlight TRUE If TRUE, knitr will highlight the source code in the final output.

prompt FALSE If TRUE, knitr will add > to the start of each line of code displayed in the final document. 

strip.white TRUE If TRUE, knitr will remove white spaces that appear at the beginning or end of a code chunk.

tidy FALSE If TRUE, knitr will tidy code chunks for display with the tidy_source() function in the formatR package.

Learn more about chunk options at http://yihui.name/knitr/options 
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option default value description
Chunks

opts.label NULL The label of options set in knitr:: opts_template() to use with the chunk.
R.options NULL Local R options to use with the chunk. Options are set with options() at start of chunk. Defaults are restored at end.
ref.label NULL A character vector of labels of the chunks from which the code of the current chunk is inherited.

Cache

autodep FALSE If TRUE, knitr will attempt to figure out dependencies between chunks automatically by analyzing object names.

cache FALSE If TRUE, knitr will cache the results to reuse in future knits. Knitr will reuse the results until the code chunk is altered.

cache.comments NULL If FALSE, knitr will not rerun the chunk if only a code comment has changed.

cache.lazy TRUE If TRUE, knitr will use lazyload() to load objects in chunk. If FALSE, knitr will use load() to load objects in chunk.

cache.path 'cache/' A file path to the directory to store cached results in. Path should begin in the directory that the .Rmd file is saved in.

cache.vars NULL A character vector of object names to cache if you do not wish to cache each object in the chunk.

dependson NULL A character vector of chunk labels to specify which other chunks a chunk depends on. Knitr will update a cached 
chunk if its dependencies change.

Animation
anipots 'controls,loop' Extra options for animations (see the animate package).
interval 1 The number of seconds to pause between animation frames.

Plots

dev 'png' The R function name that will be used as a graphical device to record plots, e.g. dev='CairoPDF'.

dev.args NULL Arguments to be passed to the device, e.g. dev.args=list(bg='yellow', pointsize=10).

dpi 72 A number for knitr to use as the dots per inch (dpi) in graphics (when applicable).

external TRUE If TRUE, knitr will externalize tikz graphics to save LaTex compilation time (only for the tikzDevice::tikz() device).

fig.align 'default' How to align graphics in the final document. One of 'left', 'right', or 'center'.

fig.cap NULL A character string to be used as a figure caption in LaTex.

fig.env 'figure' The Latex environment for figures.

fig.ext NULL The file extension for figure output, e.g. fig.ext='png'.

fig.height, fig.width 7 The width and height to use in R for plots created by the chunk (in inches).

fig.keep 'high'
If 'high', knitr will merge low-level changes into high level plots. If 'all', knitr will keep all plots (low-level changes may 

produce new plots). If 'first', knitr will keep the first plot only. If 'last', knitr will keep the last plot only. If 'none', knitr 
will discard all plots.

fig.lp 'fig:' A prefix to be used for figure labels in latex.

fig.path 'figure/' A file path to the directory where knitr should store the graphics files created by the chunk.

fig.pos '' A character string to be used as the figure position arrangement in LaTex.

fig.process NULL A function to post-process a figure file. Should take a filename and return a filename of a new figure source.

fig.retina 1 Dpi multiplier for displaying HTML output on retina screens.

fig.scap NULL A character string to be used as a short figure caption.

fig.subcap NULL A character string to be used as captions in sub-figures in LaTex.

fig.show 'asis'
If 'hide', knitr will generate the plots created in the chunk, but not include them in the final document. If 'hold', knitr 

will delay displaying the plots created by the chunk until the end of the chunk. If 'animate', knitr will combine all of 
the plots created by the chunk into an animation.

fig.showtext NULL If TRUE, knitr will call showtext::showtext.begin() before drawing plots.

out.extra NULL A character string of extra options for figures to be passed to LaTex or HTML.

out.height, out.width NULL The width and height to scale plots to in the final output. Can be in units recognized by output, e.g. 8\\linewidth, 50px

resize.height, resize.width NULL The width and height to resize tike graphics in LaTex, passed to \resizebox{}{}.

sanitize FALSE If TRUE, knitr will sanitize tike graphics for LaTex.

Chunk options (Continued)
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1. Markdown Syntax
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Slide display modes

Basic YAML

Top level options to customize LaTex (pdf) output

Contents: 
1. Markdown Syntax
2. Knitr chunk options
3. Pandoc options

--- 
title: "Chapters" 
output: 
  html_document: 

    toc: true 

    toc_depth: 2 

---

--- 
title: "Slides" 
output: 
  slidy_presentation: 
    incremental: true   
runtime: shiny 

---

--- 

title: "A Web Doc" 

author: "John Doe" 

date: "May 1, 2015" 

output: md_document 

---

html_document 
pdf_document 
word_document 
md_document 
ioslides_presentation 
slidy_presentation 
beamer_presentation

Templates Template options Interactive Docs

--- 

title: "My PDF" 

output: pdf_document 

fontsize: 11pt 

geometry: margin=1in 

---

option description

lang Document language code

fontsize Font size (e.g. 10pt, 11pt, 12 pt)

documentclass Latex document class (e.g. article)

classoption Option for document class (e.g. oneside); may be repeated

geometry Options for geometry class (e.g. margin=1in); may be repeated

mainfont, sansfont, monofont, mathfont Document fonts (works only with xelatex and lualatex, see the latex_engine option)

linkcolor, urlcolor, citecolor Color for internal, external, and citation links (red, green, magenta, cyan, blue, black)

Latex options

Syntax for slide formats (ioslides, slidy, beamer)

ioslides
f 
w 
o 
h 
p

enable fullscreen mode 
toggle widescreen mode 
enable overview mode 
enable code highlight mode 
show presenter notes

- 
- 
- 
- 
-

Press a key below during presentation to enter display mode. Press esc to exit display mode.

slidy
C 
F 
A 
S 
B

show table of contents 
toggle display of the footer 
toggle display of current vs all slides 
make fonts smaller 
make fonts bigger

- 
- 
- 
- 
-

# Dividing slides 1  

Pandoc will start a new slide at each first level header  

## Header 2   

… as well as each second level header 

*** 

You can start a new slide with a horizontal rule`***` if you do not want 
a header.  

## Bullets 

Render bullets with  

- a dash
- another dash

## Incremental bullets 

>- Use this format 
>- to have bullets appear 
>- one at a time (incrementally)

becomes
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option description

colortheme X Beamer color theme to use (e.g., colortheme: "dolphin").
css X X X Filepath to CSS style to use to style document (e.g., css: styles.css).
duration X Add a countdown timer (in minutes) to footer of slides (e.g., duration: 45).
fig_caption X X X X X X Should figures be rendered with captions?
fig_crop X X Should pdfcrop utility be automatically applied to figures (when available)?
fig_height X X X X X X X Default figure height (in inches) for document.
fig_retina X X X X Scaling to perform for retina displays (e.g., fig_retina: 2).
fig_width X X X X X X X Default figure width (in inches) for document.
font_adjustmen

t
X Increase or decrease font size for entire presentation (e.g., font_adjustment: -1).

fonttheme X Beamer font theme to use (e.g., fonttheme: "structurebold").
footer X Text to add to footer of each slide (e.g., footer: "Copyright (c) 2014 RStudio").
highlight X X X X Syntax highlighting style (e.g. "tango", "pygments", "kate", "zenburn", and 

"textmate")includes X X X X X X See below
-in_header X X X X X File of content to place in document header (e.g., in_header: header.html).
-before_body X X X X X File of content to place before document body (e.g., before_body: 

doc_prefix.html).-after_body X X X X X File of content to place after document body (e.g., after_body: doc_suffix.html).
incremental X X X Should bullets appear one at a time (on presenter mouse clicks)?
keep_md X X X Save a copy of .md file that contains knitr output (in addition to the .Rmd and HTML files)?
keep_tex X X Save a copy of .tex file that contains knitr output (in addition to the .Rmd and PDF files)?
latex_engine X Engine to render latex. Should be one of "pdflatex", "xelatex", and "lualatex".

lib_dir X X X Directory of dependency files to use (Bootstrap, MathJax, etc.) (e.g., lib_dir: libs).
logo X File path to a logo (at least 128 x 128) to add to presentation (e.g., logo: logo.png).
mathjax X X X Set to local or a URL to use a local/URL version of MathJax to render equations
number_section

s
X X Add section numbering to headers (e.g., number_sections: true).

pandoc_args X X X X X X X Arguments to pass to Pandoc (e.g., pandoc_args: ["--title-prefix", "Foo"]).
preserve_yaml X Preserve YAML front matter in final document?
reference_docx X A .docx file whose styles should be copied to use (e.g., reference_docx: 

mystyles.docx).self_contained X X X Embed dependencies into the doc? Set to false to keep dependencies in external files.
slide_level X The lowest heading level that defines individual slides (e.g., slide_level: 2).
smaller X Use the smaller font size in the presentation?
smart X X X Convert straight quotes to curly, dashes to em-dashes, … to ellipses, and so on?
template X X X X Pandoc template to use when rendering file (e.g., template: 

quarterly_report.html).
theme X X Bootswatch or Beamer theme to use for page. Valid bootswatch themes include

"cerulean", "journal", "flatly", "readable", "spacelab", "united", and "cosmo".

toc X X X X Add a table of contents at start of document? (e.g., toc: true).
toc_depth X X X The lowest level of headings to add to table of contents (e.g., toc_depth: 2).
transition X Speed of slide transitions should be "slower", "faster" or a number in seconds.

variant X The flavor of markdown to use; one of "markdown", "markdown_strict", 
"markdown_github", "markdown_mmd", and "markdown_phpextra"

widescreen X Display presentation in widescreen format?

© 2014 RStudio, Inc. CC BY RStudio.
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Base R  
Cheat Sheet 

RStudio® is a trademark of RStudio, Inc.  •  CC BY Mhairi McNeill  •  mhairihmcneill@gmail.com  Learn more at web page or vignette  •  package  version  •  Updated: 3/15

Input Ouput Description 

df <- read.table(‘file.txt’) write.table(df, ‘file.txt’) Read and write a delimited text 
file.

df <- read.csv(‘file.csv’) write.csv(df, ‘file.csv’)

Read and write a comma 
separated value file. This is a 

special case of read.table/
write.table. 

load(‘file.RData’) save(df, file = ’file.Rdata’) Read and write an R data file, a 
file type special for R. 

?mean  
Get help of a particular function. 
help.search(‘weighted mean’) 
Search the help files for a word or phrase. 
help(package = ‘dplyr’) 
Find help for a package. 

Getting Help
Accessing the help files

More about an object

str(iris) 
Get a summary of an object’s structure.  
class(iris) 
Find the class an object belongs to.

Programming
For Loop

for (variable in sequence){ 

Do something 

}

Example
for (i in 1:4){ 

j <- i + 10 

print(j) 

}

While Loop

while (condition){ 

Do something 

}

Example
while (i < 5){ 

print(i) 

i <- i + 1 

}

If Statements

if (condition){ 
Do something 

} else { 
Do something different  

}

Example
if (i > 3){ 

print(‘Yes’) 
} else { 

print(‘No’)  
}

Functions
function_name <- function(var){ 

Do something 

return(new_variable) 
}

Example
square <- function(x){ 

squared <- x*x 

return(squared) 
}

a == b Are equal a > b Greater than a >= b Greater than 
or equal to is.na(a) Is missing

a != b Not equal a < b Less than a <= b Less than or 
equal to

is.null(a) Is null 
Conditions

Creating Vectors

c(2, 4, 6) 2 4 6 Join elements into 
a vector 

2:6 2 3 4 5 6 An integer 
sequence

seq(2, 3, by=0.5) 2.0 2.5 3.0 A complex 
sequence

rep(1:2, times=3) 1 2 1 2 1 2 Repeat a vector

rep(1:2, each=3) 1 1 1 2 2 2 Repeat elements 
of a vector 

install.packages(‘dplyr’) 
Download and install a package from CRAN. 

library(dplyr)  
Load the package into the session, making all 
its functions available to use.  

dplyr::select  
Use a particular function from a package. 

data(iris) 
Load a built-in dataset into the environment. 

Using Packages

Vectors

Selecting Vector Elements 

x[4] The fourth element.

x[-4] All but the fourth.

x[2:4] Elements two to four.

x[-(2:4)] All elements except 
two to four.

x[c(1, 5)] Elements one and 
five.

x[x == 10] Elements which 
are equal to 10.

x[x < 0] All elements less 
than zero.

x[x %in%  
c(1, 2, 5)]

Elements in the set 
1, 2, 5.

By Position

By Value

Named Vectors 

x[‘apple’] Element with 
name ‘apple’.

Reading and Writing Data

Working Directory
getwd() 
Find the current working directory (where 
inputs are found and outputs are sent). 

setwd(‘C://file/path’) 
Change the current working directory. 

Use projects in RStudio to set the working  
directory to the folder you are working in.  

Vector Functions
sort(x)  
Return x sorted.

rev(x)  
Return x reversed.

table(x)  
See counts of values.

unique(x)  
See unique values.

Also see the readr package.
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Lists

Matrices

Data Frames

Maths Functions 

Types Strings 

Factors 

Statistics 

Distributions 

as.logical TRUE, FALSE, TRUE Boolean values (TRUE or FALSE).

as.numeric 1, 0, 1 Integers or floating point 
numbers.

as.character '1', '0', '1' Character strings. Generally 
preferred to factors.

as.factor
'1', '0', '1', 
levels: '1', '0'

Character strings with preset 
levels. Needed for some 

statistical models. 

Converting between common data types in R. Can always go 
from a higher value in the table to a lower value. 

> a <- 'apple'
> a
[1] 'apple'

The Environment

Variable Assignment

ls() List all variables in the 
environment.

rm(x) Remove x from the 
environment.

rm(list = ls()) Remove all variables from the
environment.

You can use the environment panel in RStudio to 
browse variables in your environment. 

factor(x) 
Turn a vector into a factor. Can 
set the levels of the factor and 

the order.

m <- matrix(x, nrow = 3, ncol = 3) 
 Create a matrix from x.

wwwwww
m[2,  ] - Select a row

m[ , 1] - Select a  column

m[2, 3] -  Select an elementwwwwww
wwwwww

t(m) 
Transpose 
m %*% n 

Matrix Multiplication 
solve(m, n) 

Find x in: m * x = n

l <- list(x = 1:5, y = c('a', 'b'))
 A list is a collection of elements which can be of different types. 

l[[2]] l[1] l$x l['y']

Second element 
of l.

New list with 
only the first 

element.

Element named 
x.

New list with 
only element 

named y.

df <- data.frame(x = 1:3, y = c('a', 'b', 'c')) 
A special case of a list where all elements are the same length.

t.test(x, y)
Perform a t-test for 
difference between 

means. 

pairwise.t.test 
 Perform a t-test for 

 paired data.

log(x) Natural log. sum(x) Sum.

exp(x) Exponential. mean(x) Mean.

max(x) Largest element. median(x) Median. 

min(x) Smallest element. quantile(x) Percentage 
quantiles.

round(x, n) Round to n decimal 
places.

rank(x) Rank of elements.

signif(x, n) Round to n 
significant figures.

var(x) The variance.

cor(x, y) Correlation. sd(x) The standard 
deviation.

x y

1 a

2 b

3 c

Matrix subsetting

df[2, ]

df[ , 2]

df[2, 2]

List subsetting

df$x df[[2]]

cbind - Bind columns.

rbind - Bind rows.

View(df) See the full data 
frame.

head(df) See the first 6 
rows.

Understanding a data frame

nrow(df) 
Number of rows. 

ncol(df) 
Number of 
columns. 

dim(df) 
Number of 
columns and 
rows.

Plotting  

Dates See the lubridate package.

Also see the ggplot2 package.

Also see the stringr package.

Also see the 
dplyr package.

plot(x) 
Values of x in 

order.

plot(x, y) 
Values of x 
against y.

hist(x) 
Histogram of 

x.

Random 
Variates 

Density 
Function

Cumulative 
Distribution

Quantile

Normal rnorm dnorm pnorm qnorm

Poisson rpois dpois ppois qpois

Binomial rbinom dbinom pbinom qbinom

Uniform runif dunif punif qunif

lm(y ~ x, data=df) 
Linear model. 

glm(y ~ x, data=df) 
Generalised linear model. 

summary 
Get more detailed information 

 out a model.

prop.test 
Test for a 
difference 
between 

proportions. 

aov 
Analysis of 
variance. 

paste(x, y, sep = ' ') Join multiple vectors together.

paste(x, collapse = ' ') Join elements of a vector together.

grep(pattern, x) Find regular expression matches in x. 

gsub(pattern, replace, x) Replace matches in x with a string.

toupper(x) Convert to uppercase.

tolower(x) Convert to lowercase.

nchar(x) Number of characters in a string. 

cut(x, breaks = 4) 
Turn a numeric vector into a 

factor by ‘cutting’ into 
sections.  
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A;B;C 
1,5;2;3 
4,5;5;NA

A B C
1.5 2 3
4.5 5 NA

write_*(x, file, na = "NA", append, col_names, quote, escape, eol, num_threads, progress)

A|B|C 
1|2|3 
4|5|NA

A B C
1 2 3
4 5 NA

Data import with the tidyverse : : CHEAT SHEET 

RStudio® is a trademark of RStudio, PBC  •  CC BY SA  RStudio  •  info@rstudio.com  •  844-448-1212  •  rstudio.com  •  Learn more at readr.tidyverse.org  •  readr  2.0.0  •  readxl  1.3.1  •  googlesheets4  1.0.0  •  Updated:  2021-08

Try one of the following  
packages to import other types of files: 

• haven - SPSS, Stata, and SAS files
• DBI - databases
• jsonlite - json
• xml2 - XML
• httr - Web APIs
• rvest - HTML (Web Scraping)
• readr::read_lines() - text data

OTHER TYPES OF DATA

COLUMN TYPES

Column Specification with readr

spec(x) 
# cols( 
#   age = col_integer(), 
#   sex = col_character(), 
#   earn = col_double() 
# )

earn is a double (numeric)
sex is a 

character

age is an 
integer

Hide col spec message 
read_*(file, show_col_types = FALSE) 

Select columns to import  
Use names, position, or selection helpers. 
read_*(file, col_select = c(age, earn)) 

Guess column types 
To guess a column type, read_ *() looks at the 
first 1000 rows of data. Increase with guess_max. 
read_*(file, guess_max = Inf)

USEFUL COLUMN ARGUMENTSColumn specifications define what data type each 
column of a file will be imported as. By default 
readr will generate a column spec when a file is 
read and output a summary.  

spec(x) Extract the full column specification for 
the given imported data frame.

Each column type has a function and 
corresponding string abbreviation. 

• col_logical() - "l"
• col_integer() - "i"
• col_double() - "d"
• col_number() - "n"
• col_character() - "c"
• col_factor(levels, ordered = FALSE) - "f"
• col_datetime(format = "") - "T"
• col_date(format = "") - "D"
• col_time(format = "") - "t"
• col_skip() - "-", "_"
• col_guess() - "?"

USEFUL READ ARGUMENTS

A B C
1 2 3

A B C
1 2 3
4 5 NA

x y z
A B C
1 2 3
4 5 NA

A B C
NA 2 3
4 5 NA

1 2 3
4 5 NA

No header 
read_csv("file.csv", col_names = FALSE) 

Provide header 
read_csv("file.csv", 
    col_names = c("x", "y", "z")) 

Read multiple files into a single table 
read_csv(c(“f1.csv”, “f2.csv”, “f3.csv"),  
    id = "origin_file")

Skip lines 
read_csv("file.csv", skip = 1) 

Read a subset of lines 
read_csv("file.csv", n_max = 1) 

Read values as missing 
read_csv("file.csv", na = c("1")) 

Specify decimal marks 
read_delim("file2.csv", locale = 
    locale(decimal_mark = ","))

Read Tabular Data with readr
read_*(file, col_names = TRUE, col_types = NULL, col_select = NULL, id = NULL, locale, n_max = Inf, 

skip = 0, na = c("", "NA"), guess_max = min(1000, n_max), show_col_types = TRUE) See ?read_delim

read_delim("file.txt", delim = "|") Read files with any delimiter. If no 
delimiter is specified, it will automatically guess. 
To make file.txt, run: write_file("A|B|C\n1|2|3\n4|5|NA", file = "file.txt") 

read_csv("file.csv") Read a comma delimited file with period 
decimal marks.  
write_file("A,B,C\n1,2,3\n4,5,NA", file = "file.csv") 

read_csv2("file2.csv") Read semicolon delimited files with comma 
decimal marks. 
write_file("A;B;C\n1,5;2;3\n4,5;5;NA", file = "file2.csv") 

read_tsv("file.tsv") Read a tab delimited file. Also read_table(). 
read_fwf("file.tsv", fwf_widths(c(2, 2, NA))) Read a fixed width file. 
write_file("A\tB\tC\n1\t2\t3\n4\t5\tNA\n", file = "file.tsv")

Save Data with readr

write_delim(x, file, delim = " ") Write files with any delimiter. 

write_csv(x, file) Write a comma delimited file. 

write_csv2(x, file) Write a semicolon delimited file. 

write_tsv(x, file) Write a tab delimited file.

A,B,C 
1,2,3 
4,5,NA

A B C
1 2 3
4 5 NA

One of the first steps of a project is to import 
outside data into R. Data is often stored in  
tabular formats, like csv files or spreadsheets. 

The front page of this sheet shows 
how to import and save text files into 
R using readr. 

The back page shows how to import 
spreadsheet data from Excel files 
using readxl or Google Sheets using 
googlesheets4.

Set a default type 
read_csv( 
    file,  
    col_type = list(.default = col_double()) 
) 
Use column type or string abbreviation 
read_csv( 
    file,  
    col_type = list(x = col_double(), y = "l", z = "_") 
) 
Use a single string of abbreviations 
# col types: skip, guess, integer, logical, character 
read_csv( 
    file,  
    col_type = "_?ilc" 
)

DEFINE COLUMN SPECIFICATION

A,B,C 
1,2,3 
4,5,NA

A B C
1 2 3
4 5 NA

A  B  C 
1  2  3 
4  5  NA

A B C
1 2 3
4 5 NA

A;B;C 
1,5;2;3,0 
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Use the range argument of readxl::read_excel() or 
googlesheets4::read_sheet() to read a subset of cells from a 
sheet.  
read_excel(path, range = "Sheet1!B1:D2") 
read_sheet(ss, range = "B1:D2") 

Also use the range argument with cell specification functions 
cell_limits(), cell_rows(), cell_cols(), and anchored().

Column specifications define what data type 
each column of a file will be imported as. 

Use the col_types argument of read_excel() to 
set the column specification. 

Guess column types 
To guess a column type, read_ excel() looks at 
the first 1000 rows of data. Increase with the 
guess_max argument. 
read_excel(path, guess_max = Inf) 

Set all columns to same type, e.g. character 
read_excel(path, col_types = "text") 

Set each column individually 
read_excel( 
    path,  
    col_types = c("text", "guess", "guess",“numeric") 
)

with readxl with googlesheets4
READ SHEETS

RStudio® is a trademark of RStudio, PBC  •  CC BY SA  RStudio  •  info@rstudio.com  •  844-448-1212  •  rstudio.com  •  readxl.tidyverse.org and googlesheets4.tidyverse.org  •  readr  2.0.0  •  readxl  1.3.1  •  googlesheets4  1.0.0  •  Updated:  2021-08

READ EXCEL FILES

Import Spreadsheets

OTHER USEFUL EXCEL PACKAGES

For functions to write data to Excel files, see: 
• openxlsx
• writexl

For working with non-tabular Excel data, see: 
• tidyxl

READXL COLUMN SPECIFICATION

read_excel(path, sheet = NULL, range = NULL) 
Read a .xls or .xlsx file based on the file extension. 
See front page for more read arguments. Also 
read_xls() and read_xlsx(). 
read_excel("excel_file.xlsx")

googlesheets4 also offers ways to modify other 
aspects of Sheets (e.g. freeze rows, set column 
width, manage (work)sheets). Go to 
googlesheets4.tidyverse.org to read more. 

For whole-file operations (e.g. renaming, sharing, 
placing within a folder), see the tidyverse 
package googledrive at 
googledrive.tidyverse.org.

READ SHEETS

read_excel(path, sheet = 
NULL) Specify which sheet 
to read by position or name. 
read_excel(path, sheet = 1) 
read_excel(path, sheet = "s1") 

excel_sheets(path) Get a 
vector of sheet names. 
excel_sheets("excel_file.xlsx") 

To read multiple sheets: 
1. Get a vector of sheet

names from the file path. 
2. Set the vector names to

be the sheet names.
3. Use purrr::map_dfr() to

read multiple files into
one data frame.

CELL SPECIFICATION FOR READXL AND GOOGLESHEETS4

WRITE SHEETS

GOOGLESHEETS4 COLUMN SPECIFICATION
Column specifications define what data type 
each column of a file will be imported as. 

Use the col_types argument of read_sheet()/
range_read() to set the column specification. 

Guess column types 
To guess a column type read_sheet()/
range_read() looks at the first 1000 rows of data. 
Increase with guess_max. 
read_sheet(path, guess_max = Inf) 

Set all columns to same type, e.g. character 
read_sheet(path, col_types = "c") 

Set each column individually 
# col types: skip, guess, integer, logical, character 
read_sheets(ss, col_types = "_?ilc")

FILE LEVEL OPERATIONS

A B C D E

s1 s2 s3

s1 s2 s3

A B C D E

s1 s2

A B C D E

s1 s2

A B C D E

s1 s2 s3

path <- "your_file_path.xlsx" 

path %>% excel_sheets() %>% 
    set_names() %>% 
    map_dfr(read_excel, path = path)

x1 x2 x3 x4 x5
x NA z 8 NA
y 7 NA 9 10

A B C D E
1 x1 x2 x3 x4 x5
2 x z 8
3 y 7 9 10

s1

2 3 4
NA y z

A B C D E
1 1 2 3 4 5
2 x y z
3 6 7 9 10

s1

• skip
• guess

• logical
• numeric
• text

• date
• list

• skip - "_" or "-"
• guess - "?"
• logical - "l"
• integer - "i"
• double - "d"
• numeric - "n"

• date - "D"
• datetime - "T"
• character - "c"
• list-column - "L"
• cell - "C" Returns

list of raw cell data.

logical numeric text date list
TRUE 2 hello 1947-01-08 hello
FALSE 3.45 world 1956-10-21 1

l n c D L
TRUE 2 hello 1947-01-08 hello
FALSE 3.45 world 1956-10-21 1

Use list for columns that include multiple data 
types. See tidyr and purrr for list-column data. Use list for columns that include multiple data 

types. See tidyr and purrr for list-column data.

write_sheet(data, ss = 
NULL, sheet = NULL) 
Write a data frame into a 
new or existing Sheet.  
gs4_create(name, ..., 
sheets = NULL) Create a 
new Sheet with a vector 
of names, a data frame, 
or a (named) list of data 
frames. 
sheet_append(ss, data, 
sheet = 1) Add rows to 
the end of a worksheet. 

x1 x2 x3
2 y 5
3 z 6

A B C
1 x1 x2 x3
2 1 x 4
3 2 y 5
4 3 z 6

s1

1 x 4
2 y 5
3 z 6

A B C
1 1 x 4
2 2 y 5
3 3 z 6

s1

read_sheet(ss, sheet = NULL, range = NULL)  
Read a sheet from a URL, a Sheet ID, or a dribble 
from the googledrive package. See front page for 
more read arguments. Same as range_read().

COLUMN TYPES

COLUMN TYPES

URLs are in the form: 
https://docs.google.com/spreadsheets/d/ 
            SPREADSHEET_ID/edit#gid=SHEET_ID 

gs4_get(ss) Get spreadsheet meta data.  

gs4_find(...) Get data on all spreadsheet files. 

sheet_properties(ss) Get a tibble of properties 
for each worksheet. Also sheet_names().

SHEETS METADATA

x1 x2 x3 x4 x5
x NA z 8 NA
y 7 NA 9 10

A B C D E
1 x1 x2 x3 x4 x5
2 x z 8
3 y 7 9 10

s1

A B C D
1
2

s1
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Output data frames as tables using 
kable(data, caption). 

```{r} 
data <- faithful[1:4, ] 
knitr::kable(data,  

caption = "Table with kable") 
``` 

Other table packages include flextable, gt, and kableExtra.

Set options for the entire document in the first chunk. 

```{r include=FALSE} 
knitr::opts_chunk$set(message = FALSE) 
```

Surround code chunks with ```{r} and ``` or use 
the Insert Code Chunk button.           Add a chunk label 
and/or chunk options inside the curly braces after r. 

```{r chunk-label, include=FALSE} 
summary(mtcars) 
```

rmarkdown : : CHEAT SHEET 

Create citations from a bibliography file, a Zotero library, 
or from DOI references.  

BUILD YOUR BIBLIOGRAPHY 
• Add BibTeX or CSL bibliographies to the YAML header.
---
title: "My Document"
bibliography: references.bib
link-citations: TRUE
---

• If Zotero is installed locally, your main library will 
automatically be available.

• Add citations by DOI by searching "from DOI" in the
Insert Citation dialog.

INSERT CITATIONS 
• Access the Insert Citations dialog in the Visual Editor

by clicking the @ symbol in the toolbar or by clicking
Insert > Citation.

• Add citations with markdown syntax by typing [@cite]
or @cite.

RStudio® is a trademark of RStudio, PBC  •  CC BY SA  RStudio  •  info@rstudio.com  •  844-448-1212  •  rstudio.com  •  Learn more at rmarkdown.rstudio.com  •  rmarkdown  2.9.4  •  Updated:  2021-08

publish to 
rpubs.com, 
shinyapps.io,  
RStudio Connect

reload document

find in document

file path to output document

What is rmarkdown?

Workflow

Rmd

Write with  
Markdown 

modify 
chunk 
options

run all 
previous 
chunks

run 
current 
chunk

insert 
code 
chunk

go to 
code 
chunk

run code 
chunk(s)

show 
outline

set 
preview 
location

4. Set Output Format(s)
and Options

3. Write Text

2. Embed Code

Insert `r  <code>` into text sections. Code is evaluated 
at render and results appear as text. 

"Built with `r getRversion()`" --> "Built with 4.1.0"

Embed Code with knitr

INLINE CODE

SET GLOBAL OPTIONS

CODE CHUNKS

.Rmd files · Develop your code and 
ideas side-by-side in a single 
document. Run code as individual 
chunks or as an entire document. 
Dynamic Documents · Knit together 
plots, tables, and results with 
narrative text. Render to a variety of 
formats like HTML, PDF, MS Word, or 
MS Powerpoint. 
Reproducible Research · Upload, link 
to, or attach your report to share. 
Anyone can read or run your code to 
reproduce your work.

insert citations

add/edit 
attributes

VISUAL EDITOR Insert Citations

Insert Tables

The syntax on the left renders as the output on the right.

OPTION DEFAULT EFFECTS
echo TRUE display code in output document

error FALSE TRUE (display error messages in doc)
FALSE (stop render when error occurs)

eval TRUE run code in chunk
include TRUE include chunk in doc after running
message TRUE display code messages in document
warning TRUE display code warnings in document

results "markup"
"asis" (passthrough results) 
"hide" (don't display results) 
"hold" (put all results below all code)

fig.align "default" "left", "right", or "center"
fig.alt NULL alt text for a figure
fig.cap NULL figure caption as a character string
fig.path "figure/" prefix for generating figure file paths
fig.width & 
fig.height 7 plot dimensions in inches

out.width rescales output width, e.g. "75%", "300px"
collapse FALSE collapse all sources & output into a single block
comment "##" prefix for each line of results
child NULL files(s) to knit and then include

purl TRUE include or exclude a code chunk when  
extracting source code with knitr::purl()

See more options and defaults by running str(knitr::opts_chunk$get()) 

6. Share

Plain text. 
End a line with two spaces to 
start a new paragraph. 
Also end with a backslash\ 
to make a new line. 
*italics* and **bold** 
superscript^2^/subscript~2~ 
~~strikethrough~~ 
escaped: \* \_ \\ 
endash: --, emdash: ---

# Header 1 
## Header 2 
... 
###### Header 6 

- unordered list 
- item 2

- item 2a (indent 1 tab)
- item 2b

1. ordered list 
2. item 2

- item 2a (indent 1 tab)
- item 2b

<link url> 
[This is a link.](link url) 
[This is another link][id]. 
   At the end of the document: 
      [id]: link url 
![Caption](image.png) 
or ![Caption][id2] 
   At the end of the document: 
      [id2]: image.png  

`verbatim code` 
``` 
multiple lines 
of verbatim code 
``` 
> block quotes 

equation: $e^{i \pi} + 1 = 0$ 

equation block:  
$$E = mc^{2}$$ 

horizontal rule: 
--- 

| Right | Left | Default | Center | 
|-------:|:------|-----------|:---------:|  
| 12 | 12 | 12 | 12 |  
| 123 | 123 | 123 | 123 |  
| 1 | 1 | 1 | 1 | 

    HTML Tabsets 
    # Results {.tabset} 
    ## Plots text 
    text 

    ## Tables 
    more text

1. New File

1. Open a new .Rmd file in the RStudio IDE by
going to File > New File > R Markdown.

2. Embed code in chunks. Run code by line, by
chunk, or all at once.

3. Write text and add tables, figures, images, and
citations. Format with Markdown syntax or the
RStudio Visual Markdown Editor.

4. Set output format(s) and options in the YAML
header. Customize themes or add parameters
to execute or add interactivity with Shiny.

5. Save and render the whole document. Knit
periodically to preview your work as you write. 

6. Share your work!

5. Save and Render

SOURCE EDITOR
RENDERED OUTPUT

style options

1

2

3

4

5

6

Plain text. 
End a line with two spaces to 
start a new paragraph. 
Also end with a backslash 
to make a new line. 
italics and bold 
superscript2/subscript2 
strikethrough 
escaped: * _ \ 
endash: –, emdash: — 

Header 1 
Header 2 
... 
Header 6 
• unordered list 
• item 2

• item 2a (indent 1 tab)
• item 2b

1. ordered list 
2. item 2

• item 2a (indent 1 tab)
• item 2b

http://www.rstudio.com/ 
This is a link. 
This is another link. 

Caption. 

 verbatim code 

   multiple lines 
 of verbatim code 

      block quotes 

equation:   
equation block:  

 

horizontal rule: 

Results
    Plots       Tables 

  text

eiπ + 1 = 0

E = m c2

Right Left Default Center
12 12 12 12

123 123 123 123

1 1 1 1
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OUTPUT FORMAT CREATES
html_document .html
pdf_document* .pdf
word_document Microsoft Word (.docx)
powerpoint_presentation Microsoft Powerpoint (.pptx)
odt_document OpenDocument Text
rtf_document Rich Text Format
md_document Markdown
github_document Markdown for Github
ioslides_presentation ioslides HTML slides
slidy_presentation Slidy HTML slides
beamer_presentation* Beamer slides
* Requires LaTeX, use tinytex::install_tinytex()
Also see flexdashboard, bookdown, distill, and blogdown.

Set Output Formats and their Options in YAML

More Header Options

When you render a  
document, rmarkdown: 
1. Runs the code and embeds 

results and text into an .md 
file with knitr. 

2. Converts the .md file into the output format with 
Pandoc.

IMPORTANT OPTIONS DESCRIPTION
anchor_sections Show section anchors on mouse hover (TRUE or FALSE) X

citation_package The LaTeX package to process citations ("default", "natbib", "biblatex") X

code_download Give readers an option to download the .Rmd source code (TRUE or FALSE) X

code_folding Let readers to toggle the display of R code ("none", "hide", or "show") X

css CSS or SCSS file to use to style document (e.g. "style.css") X

dev Graphics device to use for figure output (e.g. "png", "pdf") X X

df_print Method for printing data frames ("default", "kable", "tibble", "paged") X X X X

fig_caption Should figures be rendered with captions (TRUE or FALSE) X X X X

highlight Syntax highlighting ("tango", "pygments", "kate", "zenburn", "textmate") X X X

includes File of content to place in doc ("in_header", "before_body", "after_body") X X

keep_md Keep the Markdown .md file generated by knitting (TRUE or FALSE) X X X X

keep_tex Keep the intermediate TEX file used to convert to PDF (TRUE or FALSE) X

latex_engine LaTeX engine for producing PDF output ("pdflatex", "xelatex", or "lualatex") X

reference_docx/_doc docx/pptx file containing styles to copy in the output (e.g. "file.docx", "file.pptx") X X

theme Theme options (see Bootswatch and Custom Themes below) X

toc Add a table of contents at start of document (TRUE or FALSE) X X X X

toc_depth The lowest level of headings to add to table of contents (e.g. 2, 3) X X X X

toc_float Float the table of contents to the left of the main document content (TRUE or FALSE) X

Use ?<output format> to see all of a format's options, e.g. ?html_document

H
TM

L
PD

F
M

S 
W

or
d

M
S 

PP
T
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Parameterize your documents to reuse with new 
inputs (e.g., data, values, etc.).

1. Add parameters
in the header as
sub-values of
params.

2. Call parameters
in code using
params$<name>.

3. Set parameters
with Knit with
Parameters or the
params argument
of render().

Turn your report into an interactive 
Shiny document in 4 steps: 
1. Add runtime: shiny to the YAML header.
2. Call Shiny input functions to embed input objects.
3. Call Shiny render functions to embed reactive

output.
4. Render with rmarkdown::run() or click Run

Document in RStudio IDE.

--- 
output: html_document 
runtime: shiny 
--- 

```{r, echo = FALSE} 
numericInput("n",    
  "How many cars?", 5) 

renderTable({ 
  head(cars, input$n) 
}) 
```

Publish on RStudio Connect  
to share R Markdown documents  
securely, schedule automatic  
updates, and interact with parameters in real time. 
rstudio.com/products/connect/

Save, then Knit to preview the document output. 
The resulting HTML/PDF/MS Word/etc. document will 
be created and saved in the same directory as 
the .Rmd file. 

Use rmarkdown::render() to render/knit in the R 
console. See ?render for available options.

Render

Share

Use the document's YAML header to set an output 
format and customize it with output options.

Customize HTML documents with Bootswatch 
themes from the bslib package using the theme 
output option. 
Use bslib::bootswatch_themes() to list available 
themes.

More on bslib at pkgs.rstudio.com/bslib/. 

BOOTSWATCH THEMES STYLING WITH CSS AND SCSS
Add CSS and SCSS to your document by adding a 
path to a file with the css option in the YAML header.

--- 
title: "Document Title" 
author: "Author Name" 
output: 
  html_document: 
    theme: 
      bootswatch: solar 
---

--- 
title: "My Document" 
author: "Author Name" 
output: 
  html_document: 
    css: "style.css" 
---

--- 
title: "My Document" 
author: "Author Name" 
output: 
  html_document: 
    toc: TRUE 
---

PARAMETERS

--- 
params: 
  state: "hawaii" 
---

```{r} 
data <- df[, params$state] 
summary(data) 
```

INTERACTIVITY

CUSTOM THEMES
Customize individual HTML elements using bslib 
variables. Use ?bs_theme to see more variables.

Apply CSS styling by writing HTML tags directly or: 
• Use markdown to apply style attributes inline.

Bracketed Span
A [green]{.my-color} word.  

Fenced Div
::: {.my-color}
All of these words 
are green. 
::: 

• Use the Visual Editor. Go to Format > Div/Span and
add CSS styling directly with Edit Attributes.

--- 
output: 
  html_document: 
    theme: 
      bg: "#121212" 
      fg: "#E4E4E4" 
      base_font: 

google: "Prompt" 
---

Also see Shiny Prerendered for better performance. 
rmarkdown.rstudio.com/
authoring_shiny_prerendered  

Embed a complete app into your document with 
shiny::shinyAppDir(). More at bookdown.org/yihui/
rmarkdown/shiny-embedded.html. 

REUSABLE TEMPLATES
1. Create a new package with a inst/rmarkdown/

templates directory.
2. Add a folder containing template.yaml (below)

and skeleton.Rmd (template contents). 
--- 
name: "My Template" 
--- 

3. Install the package to access template by going to
File > New R Markdown > From Template.

This is a div with some text in it.

... .my-css-tag

A green word.

All of these words 
are green.

Indent format 2 characters, 
indent options 4 characters

.Rmd .md
HTML 
PDF 
DOC

knitr pandoc
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Search inside 
environment

Syntax highlighting based 
on your file's extension

Code diagnostics that appear in the margin. 
Hover over diagnostic symbols for details.

Tab completion to finish function 
names, file paths, arguments, and more.

Multi-language code snippets to 
quickly use common blocks of code.

Open in new 
window

Save Find and 
replace

Compile as 
notebook

Run 
selected 
code

Re-run 
previous code

Source with or  
w/out Echo or  
as a Local Job

Show file 
outline

Jump to function in file Change file type

Navigate 
backwards/
forwards

A File browser keyed to your working directory. 
Click on file or directory name to open.

Path to displayed directory

Create 
folder

Delete 
file 

Rename 
file 

Change  
directory

Displays saved objects by 
type with short description

View function 
source code

View in data 
viewer

Load 
workspace

Save 
workspace

Import data 
with wizard

Clear R 
workspace

Display objects 
as list or grid

Choose environment to display from 
list of parent environments

History of past 
commands to 
run/copy

Manage 
external 
databases

Working 
Directory

Maximize, 
minimize panes

Drag pane 
boundaries

Multiple cursors/column selection 
with Alt + mouse drag.

R tutorials

Ctrl/Cmd + ! 
to see history

More file 
options

RStudio IDE : : CHEAT SHEET 
Source Editor
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RStudio opens plots in a dedicated Plots pane

Navigate 
recent plots

Open in 
window

Export 
plot

Delete 
plot

Delete 
all plots

RStudio opens documentation in a dedicated Help pane

Home page of 
helpful links 

Search within 
help file

Search for 
help file

Viewer pane displays HTML content, such as Shiny 
apps, RMarkdown reports, and interactive visualizations

Stop Shiny 
app

Publish to shinyapps.io, 
rpubs, RSConnect, …

Refresh 

Tab Panes
Open Shiny, R Markdown, 
knitr, Sweave, LaTeX, .Rd files 
and more in Source Pane

RStudio recognizes that files named app.R, 
server.R, ui.R, and global.R belong to a shiny app

Run 
app

Choose 
location to 
view app

Publish to 
shinyapps.io 
or server

Manage 
publish 
accounts

Documents and Apps

Access markdown guide at  
Help > Markdown Quick Reference 
See reverse side for more on Visual Editor

Check 
spelling

Render 
output

Choose 
output 
format

Configure 
render 
options

Insert 
code 
chunk

Jump to 
previous 
chunk

Jump 
to next 
chunk

Run 
code

Publish 
to server

Show file 
outline

Set knitr 
chunk 
options

Run this and 
all previous 
code chunks

Run this 
code chunkJump to 

section 
or chunk

Visual 
Editor 
(reverse 
side)

GUI Package manager lists every installed package

Click to load package with 
library(). Unclick to detach 
package with detach().

Delete 
from 
library

Install 
Packages

Update 
Packages

Package 
version 
installed

Browse 
package site

View(<data>) opens spreadsheet like view of data set

Sort by 
values

Filter rows by value 
or value range

Search 
for value

Turn on at Tools > Project Options > Git/SVN
• Added 
• Deleted 

• Modified 
• Renamed • Untracked

A

D

M

R
?

Stage 
files:

Show file diff to view file differences

Current 
branch

Commit 
staged files

Push/Pull  
to remote

View 
History

Open shell to type commands

Version 
Control

Package Development

Roxygen guide at Help > Roxygen Quick Reference  

See package information in the Build Tab

Create a new package with 
File > New Project > New Directory > R Package 
Enable roxygen documentation with 
Tools > Project Options > Build Tools

Install package 
and restart R

Run R CMD 
check

Run devtools::load_all() 
and reload changes

Customize 
package build 
options

Run 
package 
tests

Clear output 
and rebuild

Use debug(), browser(), or a breakpoint and execute 
your code to open the debugger mode.

Debug Mode

Examine variables 
in executing 
environment

Click next to line number to 
add/remove a breakpoint.

Select function 
in traceback to 
debug

Highlighted line shows where 
execution has paused

Run commands in 
environment where 
execution has paused

Step through 
code one line 
at a time

Step into and 
out of functions 
to run

Resume 
execution

Quit debug 
mode

Open traceback to examine 
the functions that R called 
before the error occurred

Launch debugger 
mode from origin 
of error

View 
memory 
usage

R Markdown 
Build Log

Run scripts in 
separate sessions
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RUN CODE Windows/Linux Mac
Search command history Ctrl+! Cmd+!
Interrupt current command Esc Esc
Clear console Ctrl+L Ctrl+L

NAVIGATE CODE
Go to File/Function Ctrl+. Ctrl+.

WRITE CODE
Attempt completion Tab or 

Ctrl+Space
Tab or 
    Ctrl+Space

Insert <- (assignment operator) Alt+- Option+-
Insert %>% (pipe operator) Ctrl+Shift+M Cmd+Shift+M
(Un)Comment selection Ctrl+Shift+C Cmd+Shift+C

MAKE PACKAGES Windows/Linux Mac
Load All (devtools) Ctrl+Shift+L Cmd+Shift+L
Test Package (Desktop) Ctrl+Shift+T Cmd+Shift+T
Document Package Ctrl+Shift+D Cmd+Shift+D
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Extend the open source server with a  
commercial license, support, and more:

• open and run multiple R sessions at once
• tune your resources to improve performance
• administrative tools for managing user sessions
• collaborate real-time with others in shared projects
• switch easily from one version of R to a different version
• integrate with your authentication, authorization, and audit practices
• work in the RStudio IDE, JupyterLab, Jupyter Notebooks, or VS Code

Download a free 45 day evaluation at  
www.rstudio.com/products/workbench/evaluation/ 

WHY RSTUDIO WORKBENCH?

Keyboard Shortcuts
DOCUMENTS AND APPS
Knit Document (knitr) Ctrl+Shift+K Cmd+Shift+K
Insert chunk (Sweave & Knitr) Ctrl+Alt+I Cmd+Option+I
Run from start to current line Ctrl+Alt+B Cmd+Option+B

MORE KEYBOARD SHORTCUTS
Keyboard Shortcuts Help Alt+Shift+K Option+Shift+K
Show Command Palette Ctrl+Shift+P Cmd+Shift+P

RStudio  
Workbench

Visual Editor

Share Projects

Share Project 
with Collaborators

Active shared 
collaborators

Select  
R Version

Start new R Session 
in current  project 

Close R Session 
in project 

JHT

Name of 
current 
project

RStudio saves the call history, 
workspace, and working 
directory associated with a 
project. It reloads each when 
you re-open a project. 

File > New Project

Check 
spelling

Render 
output

Choose 
output 
format

Choose 
output 
location

Insert 
code 
chunk

Jump to 
previous 
chunk

Jump 
to next 
chunk

Run 
selected 
lines

Publish 
to server

Show file 
outline

Set knitr 
chunk 
options

Run this and 
all previous 
code chunks

Run this 
code chunk

Back to 
Source Editor 
(front page)

File outline

Jump to chunk 
or header

Add/Edit 
attributes

Block 
format

Insert 
verbatim 
code

Clear 
formatting

Lists and 
block 
quotes

Links Citations Images

More 
formatting

Insert blocks, 
citations, 
equations, and 
special 
characters

Insert and 
edit tables

Search for keyboard shortcuts with 
Tools > Show Command Palette 
or Ctrl/Cmd + Shift + P.

View the Keyboard Shortcut Quick 
Reference with Tools > Keyboard 
Shortcuts or Alt/Option + Shift + K

Run Remote Jobs
Run R on remote clusters 
(Kubernetes/Slurm) via the 
Job Launcher

Launch a jobMonitor 
launcher jobs

Run launcher 
jobs remotely
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Summarise Cases

Use rowwise(.data, …) to group data into individual rows. dplyr 
functions will compute results for each row. Also apply functions 
to list-columns. See tidyr cheat sheet for list-column workflow.

wwwwwww

Use group_by(.data, …, .add = FALSE, .drop = TRUE) to create a 
"grouped" copy of a table grouped by columns in ... dplyr 
functions will manipulate each "group" separately and combine 
the results.

Apply summary functions to columns to create a new table of 
summary statistics. Summary functions take vectors as input and 
return one value (see back).

www

www

summarise(.data, …) 
Compute table of summaries.  
summarise(mtcars, avg = mean(mpg)) 

count(.data, …, wt = NULL, sort = FALSE, name = 
NULL) Count number of rows in each group 
defined by the variables in … Also tally(). 
count(mtcars, cyl)

RStudio® is a trademark of RStudio, PBC  •  CC BY SA  RStudio  •  info@rstudio.com  •  844-448-1212  •  rstudio.com  •  Learn more at dplyr.tidyverse.org  •  dplyr  1.0.7  •  Updated:  2021-07

Each observation, or 
case, is in its own row

Each variable is in 
its own column

&

dplyr functions work with pipes and expect tidy data. In tidy data:

pipes

x %>% f(y)  
becomes  f(x, y) filter(.data, …, .preserve = FALSE) Extract rows 

that meet logical criteria.  
filter(mtcars, mpg > 20) 

distinct(.data, …, .keep_all = FALSE) Remove 
rows with duplicate values.  
distinct(mtcars, gear) 

slice(.data, …, .preserve = FALSE) Select rows 
by position.  
slice(mtcars, 10:15) 

slice_sample(.data, …, n, prop, weight_by = 
NULL, replace = FALSE) Randomly select rows. 
Use n to select a number of rows and prop to 
select a fraction of rows. 
slice_sample(mtcars, n = 5, replace = TRUE) 

slice_min(.data, order_by, …, n, prop, 
with_ties = TRUE) and slice_max() Select rows 
with the lowest and highest values. 
slice_min(mtcars, mpg, prop = 0.25) 

slice_head(.data, …, n, prop) and slice_tail() 
Select the first or last rows. 
slice_head(mtcars, n = 5)

Row functions return a subset of rows as a new table.

See ?base::Logic and ?Comparison for help.

arrange(.data, …, .by_group = FALSE) Order 
rows by values of a column or columns (low to 
high), use with desc() to order from high to low. 
arrange(mtcars, mpg) 
arrange(mtcars, desc(mpg))

add_row(.data, …, .before = NULL, .after = NULL) 
Add one or more rows to a table. 
add_row(cars, speed = 1, dist = 1)

Group Cases

Manipulate Cases
EXTRACT VARIABLES

ADD CASES

ARRANGE CASES

Logical and boolean operators to use with filter()

Column functions return a set of columns as a new vector or table.

contains(match)  
ends_with(match) 
starts_with(match) 

:, e.g. mpg:cyl 
-, e.g, -gear 
everything()

num_range(prefix, range) 
all_of(x)/any_of(x, …, vars) 
matches(match)

pull(.data,  var = -1, name = NULL, …) Extract 
column values as a vector, by name or index. 
pull(mtcars, wt) 

select(.data, …) Extract columns as a table. 
select(mtcars, mpg, wt) 

relocate(.data, …, .before = NULL, .after = NULL) 
Move columns to new position. 
relocate(mtcars, mpg, cyl, .after = last_col())

Manipulate Variables

Use these helpers with select() and across() 
e.g. select(mtcars, mpg:cyl)

Apply vectorized functions to columns. Vectorized functions take 
vectors as input and return vectors of the same length as output 
(see back).

mutate(.data, …, .keep = "all", .before = NULL,  
.after = NULL) Compute new column(s). Also 
add_column(), add_count(), and add_tally(). 
mutate(mtcars, gpm = 1 / mpg) 

transmute(.data, …) Compute new column(s), 
drop others.  
transmute(mtcars, gpm = 1 / mpg) 

rename(.data, …) Rename columns. Use 
rename_with() to rename with a function. 
rename(cars, distance = dist)

MAKE NEW VARIABLES

EXTRACT CASES

wwwwww
wwwwww

wwwwww

wwwwww

wwwwww

wwwwww

wwww

wwwww

wwwwww
www

summary function

vectorized function

Data transformation with dplyr : : CHEAT SHEET 

A B CA B C

wwww

MANIPULATE MULTIPLE VARIABLES AT ONCE

across(.cols, .funs, …, .names = NULL) Summarise 
or mutate multiple columns in the same way.  
summarise(mtcars, across(everything(), mean)) 

c_across(.cols) Compute across columns in  
row-wise data. 
transmute(rowwise(UKgas), total = sum(c_across(1:2)))

wwwwww

ungroup(x, …) Returns ungrouped copy of table. 
ungroup(g_mtcars)

wwwwwwwww

www
mtcars  %>% 
   group_by(cyl) %>% 
   summarise(avg = mean(mpg))

starwars %>% 
   rowwise() %>% 
   mutate(film_count = length(films))

www== < <= is.na() %in% | xor()
!= > >= !is.na() ! &
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OFFSET 
dplyr::lag() - offset elements by 1 
dplyr::lead() - offset elements by -1 

CUMULATIVE AGGREGATE 
dplyr::cumall() - cumulative all() 
dplyr::cumany() - cumulative any() 

cummax() - cumulative max() 
dplyr::cummean() - cumulative mean() 

cummin() - cumulative min() 
cumprod() - cumulative prod() 
cumsum() - cumulative sum() 

RANKING 
dplyr::cume_dist() - proportion of all values <= 
dplyr::dense_rank() - rank w ties = min, no gaps 
dplyr::min_rank() - rank with ties = min 
dplyr::ntile() - bins into n bins 
dplyr::percent_rank() - min_rank scaled to [0,1] 
dplyr::row_number() - rank with ties = "first" 

MATH 
+, - , *, /, ^, %/%, %% - arithmetic ops 
log(), log2(), log10() - logs 
<, <=, >, >=, !=, == - logical comparisons 

dplyr::between() - x >= left & x <= right 
dplyr::near() - safe == for floating point numbers 

MISCELLANEOUS 
dplyr::case_when() - multi-case if_else() 
              starwars %>% 

mutate(type = case_when( 
height > 200 | mass > 200 ~ "large", 

species == "Droid"           ~ "robot", 
TRUE ~ "other") 

                          ) 
dplyr::coalesce() - first non-NA values by 
              element  across a set of vectors 
dplyr::if_else() - element-wise if() + else() 
dplyr::na_if() - replace specific values with NA 

pmax() - element-wise max() 
pmin() - element-wise min() 

mutate() and transmute() apply vectorized 
functions to columns to create new columns. 
Vectorized functions take vectors as input and 
return vectors of the same length as output.

Vectorized Functions
TO USE WITH MUTATE ()

vectorized function

Summary Functions
TO USE WITH SUMMARISE ()

summarise() applies summary functions to 
columns to create a new table. Summary 
functions take vectors as input and return single 
values as output.

COUNT 
dplyr::n() - number of values/rows 
dplyr::n_distinct() - # of uniques 

sum(!is.na()) - # of non-NA’s 

POSITION 
mean() - mean, also mean(!is.na()) 
median() - median 

LOGICAL 
mean() - proportion of TRUE’s 
sum() - # of TRUE’s 

ORDER 
dplyr::first() - first value 
dplyr::last() - last value 
dplyr::nth() - value in nth location of vector 

RANK 
quantile() - nth quantile 
min() - minimum value 
max() - maximum value 

SPREAD 
IQR() - Inter-Quartile Range 
mad() - median absolute deviation 
sd() - standard deviation 
var() - variance

Row Names
Tidy data does not use rownames, which store a 
variable outside of the columns. To work with the 
rownames, first move them into a column. 
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tibble::rownames_to_column() 
Move row names into col. 
a <- rownames_to_column(mtcars, 
var = "C") 

tibble::column_to_rownames() 
Move col into row names.  
column_to_rownames(a, var = "C") 

summary function

Also tibble::has_rownames() and 
tibble::remove_rownames().

Combine Tables
COMBINE VARIABLES COMBINE CASES

bind_cols(…, .name_repair) Returns tables 
placed side by side as a single table. Column 
lengths must be equal. Columns will NOT be 
matched by id (to do that look at Relational Data 
below), so be sure to check that both tables are 
ordered the way you want before binding.

left_join(x, y, by = NULL, copy = FALSE,  
suffix = c(".x", ".y"), …, keep = FALSE, 
na_matched = "na") Join matching 
values from y to x. 

right_join(x, y, by = NULL, copy = FALSE,  
suffix = c(".x", ".y"), …, keep = FALSE, 
na_matches = "na") Join matching 
values from x to y. 

inner_join(x, y, by = NULL, copy = FALSE,  
suffix = c(".x", ".y"), …, keep = FALSE, 
na_matches = "na") Join data. Retain 
only rows with matches. 

full_join(x, y, by = NULL, copy = FALSE,  
suffix = c(".x", ".y"), …, keep = FALSE, 
na_matches = "na") Join data. Retain all 
values, all rows. 

Use by = c("col1", "col2", …)  to 
specify one or more common 
columns to match on. 
left_join(x, y, by = "A") 

Use a named vector,  by = c("col1" = 
"col2"), to match on columns that 
have different names in each table. 
left_join(x, y, by = c("C" = "D")) 

Use suffix to specify the suffix to 
give to unmatched columns that 
have the same name in both tables. 
left_join(x, y, by = c("C" = "D"),  
suffix = c("1", "2"))

Use a "Filtering Join" to filter one table against 
the rows of another. 

semi_join(x, y, by = NULL, copy = FALSE, 
…, na_matches = "na") Return rows of x 
that have a match in y.  Use to see what 
will be included in a join. 

anti_join(x, y, by = NULL, copy = FALSE, 
…, na_matches = "na") Return rows of x 
that do not have a match in y. Use to see 
what will not be included in a join.

A B
1 a t
2 b u
3 c v

C A B
1 a t
2 b u
3 c v

A B
t 1 a
u 2 b
v 3 c

A B C
1 a t
2 b u
3 c v

x y
A B C
a t 1
b u 2
c v 3

E F G
a t 3
b u 2
d w 1

+ =
A B C
a t 1
b u 2
c v 3

E F G
a t 3
b u 2
d w 1

A B C D
a t 1 3
b u 2 2
c v 3 NA

A B C D
a t 1 3
b u 2 2
d w NA 1

A B C D
a t 1 3
b u 2 2

A B C D
a t 1 3
b u 2 2
c v 3 NA

d w NA 1

A B.x C B.y D
a t 1 t 3
b u 2 u 2
c v 3 NA NA

A.x B.x C A.y B.y
a t 1 d w
b u 2 b u
c v 3 a t

A1 B1 C A2 B2
a t 1 d w
b u 2 b u
c v 3 a t

x

y

A B C
a t 1
b u 2

A B C
c v 3
d w 4+

DF A B C
x a t 1
x b u 2
y c v 3
y d w 4

Use setequal() to test whether two data sets 
contain the exact same rows (in any order). 

intersect(x, y, …) 
Rows that appear in both x and y. 

setdiff(x, y, …) 
Rows that appear in x but not y. 

union(x, y, …) 
Rows that appear in x or y.  
(Duplicates removed). union_all() 
retains duplicates.

A B C
c v 3

A B C
a t 1
b u 2
c v 3
d w 4

A B C
a t 1
b u 2

x y
A B C
a t 1
b u 2
c v 3

A B D
a t 3
b u 2
d w 1

+ =

A B C
c v 3

A B C
a t 1
b u 2

Use a "Mutating Join" to join one table to 
columns from another, matching values with the 
rows that they correspond to. Each join retains a 
different combination of values from the tables. 

RELATIONAL DATA

bind_rows(…, .id = NULL) 
Returns tables one on top of the 
other as a single table. Set .id to 
a column name to add a column 
of the original table names (as 
pictured).

SET OPERATIONSCOLUMN MATCHING FOR JOINS

Use a "Nest Join" to inner join one table to 
another into a nested data frame.

A B C y
a t 1 <tibble [1x2]>
b u 2 <tibble [1x2]>
c v 3 <tibble [1x2]>

nest_join(x, y, by = NULL, copy = 
FALSE, keep = FALSE, name = 
NULL, …) Join data, nesting 
matches from y in a single new 
data frame column.
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Data tidying with tidyr : : CHEAT SHEET 

&

Tidy data is a way to organize tabular data in a 
consistent data structure across packages.  
A table is tidy if:

Each variable is in 
its own column

Each observation, or 
case, is in its own row

A B C A B C

A B C

Access variables 
as vectors

Preserve cases in 
vectorized operations

*A B C

Tibbles
Tibbles are a table format provided  
by the tibble package. They inherit the  
data frame class, but have improved behaviors: 
• Subset a new tibble with ], a vector with [[ and $.
• No partial matching when subsetting columns.
• Display concise views of the data on one screen.

A tibble: 3 × 2 
      x     y 
  <int> <chr> 
1     1     a 
2     2     b 
3     3     c

Both make 
this tibble

CONSTRUCT A TIBBLE

as_tibble(x, …) Convert a data frame to a tibble. 

enframe(x, name = "name", value = "value")  
Convert a named vector to a tibble. Also deframe(). 

is_tibble(x) Test whether x is a tibble.

AN ENHANCED DATA FRAME

options(tibble.print_max = n, tibble.print_min = m, 
tibble.width = Inf) Control default display settings. 

View() or glimpse() View the entire data set.

tibble(…) Construct by columns. 
tibble(x = 1:3, y = c("a", "b", "c")) 

tribble(…) Construct by rows. 
tribble(~x,   ~y, 

1, "a", 
2, "b", 
3, "c")

Reshape Data - Pivot data to reorganize values into a new layout.

Handle Missing Values

x1 x2
A 1
B NA
C NA
D 3
E NA

x1 x2
A 1
D 3

x

x1 x2
A 1
B NA
C NA
D 3
E NA

x1 x2
A 1
B 1
C 1
D 3
E 3

x

x1 x2
A 1
B NA
C NA
D 3
E NA

x1 x2
A 1
B 2
C 2
D 3
E 2

x

drop_na(data, …) Drop 
rows containing NA’s in … 
columns. 
drop_na(x, x2) 

fill(data, …, .direction = 
"down") Fill in NA’s in … 
columns using the next or 
previous value. 
fill(x, x2) 

replace_na(data, replace) 
Specify a value to replace 
NA in selected columns. 
replace_na(x, list(x2 = 2))

Expand 
Tables

expand(data, …) Create a 
new tibble with all possible 
combinations of the values 
of the variables listed in …   
Drop other variables. 
expand(mtcars, cyl, gear, 
carb) 

complete(data, …, fill = 
list()) Add missing possible 
combinations of values of 
variables listed in … Fill 
remaining variables with NA. 
complete(mtcars, cyl, gear, 
carb)

x1 x2 x3
A 1 3
B 1 4
B 2 3

x1 x2
A 1
A 2
B 1
B 2

x

pivot_longer(data, cols, names_to = "name",  
values_to = "value", values_drop_na = FALSE) 

"Lengthen" data by collapsing several columns 
into two. Column names move to a new 
names_to column and values to a new values_to 
column. 

pivot_longer(table4a, cols = 2:3, names_to ="year", 
    values_to = "cases")

pivot_wider(data, names_from = "name",  
values_from = "value")  

The inverse of pivot_longer(). "Widen" data by 
expanding two columns into several. One column 
provides the new column names, the other the 
values. 

pivot_wider(table2, names_from = type, 
    values_from = count)

- Use these functions to split or combine cells into individual, isolated values.Split Cells
unite(data, col, …, sep = "_", remove = TRUE, 
na.rm = FALSE) Collapse cells across several 
columns into a single column. 

unite(table5, century, year, col = "year", sep = "") 

separate(data, col, into, sep = "[^[:alnum:]]+", 
remove = TRUE, convert = FALSE, extra = "warn", 
fill = "warn", …) Separate each cell in a column 
into several columns. Also extract(). 

separate(table3, rate, sep = "/", 
    into = c("cases", "pop")) 

separate_rows(data, …, sep = "[^[:alnum:].]+", 
convert = FALSE) Separate each cell in a column 
into several rows. 

separate_rows(table3, rate, sep = "/")

x1 x2 x3
A 1 3
A 2 NA
B 1 4
B 2 3

x

Create new combinations of variables or identify 
implicit missing values (combinations of 
variables not present in the data).

Drop or replace explicit missing values (NA).

table4a
country 1999 2000

A 0.7K 2K
B 37K 80K
C 212K 213K

country year cases
A 1999 0.7K
B 1999 37K
C 1999 212K
A 2000 2K
B 2000 80K
C 2000 213K

country year cases pop
A 1999 0.7K 19M
A 2000 2K 20M
B 1999 37K 172M
B 2000 80K 174M
C 1999 212K 1T
C 2000 213K 1T

table2
country year type count

A 1999 cases 0.7K
A 1999 pop 19M
A 2000 cases 2K
A 2000 pop 20M
B 1999 cases 37K
B 1999 pop 172M
B 2000 cases 80K
B 2000 pop 174M
C 1999 cases 212K
C 1999 pop 1T
C 2000 cases 213K
C 2000 pop 1T

country year rate
A 1999 0.7K/19M0
A 2000 0.2K/20M0
B 1999 .37K/172M
B 2000 .80K/174M

country year cases pop
A 1999 0.7K 19M
A 2000 2K 20M
B 1999 37K 172
B 2000 80K 174

table3

country century year
A 19 99
A 20 00
B 19 99
B 20 00

country year
A 1999
A 2000
B 1999
B 2000

table5

country year rate
A 1999 0.7K/19M0
A 2000 0.2K/20M0
B 1999 .37K/172M
B 2000 .80K/174M

country year rate
A 1999 0.7K
A 1999 19M
A 2000 2K
A 2000 20M
B 1999 37K
B 1999 172M
B 2000 80K
B 2000 174M

table3

x1 x2 x3
A 1 3
B 1 4
B 2 3
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tibble::tribble(…) Makes list-columns when needed. 
tribble( ~max, ~seq, 

3,    1:3, 
4,    1:4, 
5,    1:5) 

tibble::tibble(…) Saves list input as list-columns. 
tibble(max = c(3, 4, 5), seq = list(1:3, 1:4, 1:5)) 
tibble::enframe(x, name="name", value="value") 
Converts multi-level list to a tibble with list-cols. 
enframe(list('3'=1:3, '4'=1:4, '5'=1:5), 'max', 'seq')

RStudio® is a trademark of RStudio, PBC  •  CC BY SA  RStudio  •  info@rstudio.com  •  844-448-1212  •  rstudio.com  •  Learn more at tidyr.tidyverse.org  •  tibble  3.1.2  •  tidyr  1.1.3  •  Updated:  2021–08

nest(data, …) Moves groups of cells into a list-column of a data 
frame. Use alone or with dplyr::group_by(): 

1. Group the data frame with group_by() and use nest() to move
the groups into a list-column.
n_storms <- storms %>%
    group_by(name) %>% 
    nest() 

2. Use nest(new_col = c(x, y)) to specify the columns to group
using dplyr::select() syntax.
n_storms <- storms %>%
    nest(data = c(year:long))

Nested Data

CREATE NESTED DATA

nested data frame

"cell" contents

name data
Amy <tibble [50x3]>
Bob <tibble [50x3]>
Zeta <tibble [50x3]>

name yr lat long

Amy 1975 27.5 -79.0
Amy 1975 28.5 -79.0
Amy 1975 29.5 -79.0
Bob 1979 22.0 -96.0
Bob 1979 22.5 -95.3
Bob 1979 23.0 -94.6
Zeta 2005 23.9 -35.6
Zeta 2005 24.2 -36.1
Zeta 2005 24.7 -36.6

name yr lat long

Amy 1975 27.5 -79.0
Amy 1975 28.5 -79.0
Amy 1975 29.5 -79.0
Bob 1979 22.0 -96.0
Bob 1979 22.5 -95.3
Bob 1979 23.0 -94.6
Zeta 2005 23.9 -35.6
Zeta 2005 24.2 -36.1
Zeta 2005 24.7 -36.6

yr lat long
1975 27.5 -79.0
1975 28.5 -79.0
1975 29.5 -79.0

yr lat long
1979 22.0 -96.0
1979 22.5 -95.3
1979 23.0 -94.6

yr lat long
2005 23.9 -35.6
2005 24.2 -36.1
2005 24.7 -36.6

Index list-columns with [[]]. n_storms$data[[1]]

TRANSFORM NESTED DATA
A vectorized function takes a vector, transforms each element in 
parallel, and returns a vector of the same length. By themselves 
vectorized functions cannot work with lists, such as list-columns. 

dplyr::rowwise(.data, …) Group data so that each row is one 
group, and within the groups, elements of list-columns appear 
directly (accessed with [[ ), not as lists of length one. When you 
use rowwise(), dplyr functions will seem to apply functions to 
list-columns in a vectorized fashion.

max seq
3 <int [3]>
4 <int [4]>
5 <int [5]>

n_storms %>% 
    rowwise() %>% 
    mutate(n = list(dim(data)))

starwars %>% 
    rowwise() %>%  
    mutate(transport = list(append(vehicles, starships)))

n_storms %>% 
    rowwise() %>% 
    mutate(n = nrow(data))

Apply a function to a list-column and create a new list-column.

Apply a function to a list-column and create a regular column.

Collapse multiple list-columns into a single list-column.

See purrr package for more list functions.

data
<tibble [50x4]>
<tibble [50x4]>
<tibble [50x4]>

fun( , …) 
fun(                      , …) 
fun(                      , …)

data
<tibble [50x4]>
<tibble [50x4]>
<tibble [50x4]>

result
result 1
result 2
result 3

data
<tibble [50x4]>
<tibble [50x4]>
<tibble [50x4]>

append() returns a list for each 
row, so col type must be list

CREATE TIBBLES WITH LIST-COLUMNS

dplyr::mutate(), transmute(), and summarise() will output 
list-columns if they return a list. 
mtcars %>%  
    group_by(cyl) %>%  
    summarise(q = list(quantile(mpg)))

OUTPUT LIST-COLUMNS FROM OTHER FUNCTIONS

A nested data frame stores individual tables as a list-column of data frames within a larger organizing data frame. List-columns can also be lists of vectors or lists of varying data types. 
Use a nested data frame to: 
• Preserve relationships between observations and subsets of data. Preserve the type of the variables being nested (factors and datetimes aren't coerced to character).
• Manipulate many sub-tables at once with purrr functions like map(), map2(), or pmap() or with dplyr rowwise() grouping.

dim() returns two 
values per row

unnest(data, cols, ..., keep_empty = FALSE) Flatten nested columns 
back to regular columns. The inverse of nest(). 
n_storms %>% unnest(data) 

unnest_longer(data, col, values_to = NULL, indices_to = NULL) 
Turn each element of a list-column into a row.

RESHAPE NESTED DATA

name films
Luke <chr [5]>

C-3PO <chr [6]>
R2-D2 <chr[7]>

name films
Luke The Empire Strik…
Luke Revenge of the S…
Luke Return of the Jed…

C-3PO The Empire Strik…
C-3PO Attack of the Cl…
C-3PO The Phantom M…
R2-D2 The Empire Strik…
R2-D2 Attack of the Cl…
R2-D2 The Phantom M…

unnest_wider(data, col) Turn each element of a list-column into a  
regular column. 

hoist(.data, .col, ..., .remove = TRUE) Selectively pull list components 
out into their own top-level columns. Uses purrr::pluck() syntax for 
selecting from lists.

name films
Luke <chr [5]>

C-3PO <chr [6]>
R2-D2 <chr[7]>

name ..1 ..2 ..3
Luke The Empire... Revenge of... Return of... 

C-3PO The Empire... Attack of... The Phantom... 
R2-D2 The Empire... Attack of... The Phantom... 

name films
Luke <chr [5]>

C-3PO <chr [6]>
R2-D2 <chr[7]>

name first_film second_film films
Luke The Empire… Revenge of… <chr [3]>

C-3PO The Empire… Attack of… <chr [4]>
R2-D2 The Empire… Attack of… <chr [5]>

starwars %>% 
    select(name, films) %>% 
    unnest_longer(films)

starwars %>% 
    select(name, films) %>% 
    unnest_wider(films)

starwars %>% 
    select(name, films) %>%  
    hoist(films, first_film = 1, second_film = 2)

starwars %>%  
    rowwise() %>%  
    mutate(n_transports = length(c(vehicles, starships)))

Apply a function to multiple list-columns.

wrap with list to tell mutate 
to create a list-column

length() returns one 
integer per row

nrow() returns one 
integer per row
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Data visualization with ggplot2 : : CHEAT SHEET 
ggplot2 is based on the grammar of graphics, the idea 
that you can build every graph from the same 
components: a data set, a coordinate system, 
and geoms—visual marks that represent data points.

Basics
GRAPHICAL PRIMITIVES

a + geom_blank() and a + expand_limits() 
Ensure limits include values across all plots. 

b + geom_curve(aes(yend = lat + 1,  
xend = long + 1), curvature = 1) - x, xend, y, yend, 
alpha, angle, color, curvature, linetype, size 

a + geom_path(lineend = "butt",  
linejoin = "round", linemitre = 1)  
x, y, alpha, color, group, linetype, size 

a + geom_polygon(aes(alpha = 50)) - x, y, alpha, 
color, fill, group, subgroup, linetype, size 

b + geom_rect(aes(xmin = long, ymin = lat,  
xmax = long + 1, ymax = lat + 1)) - xmax, xmin, 
ymax, ymin, alpha, color, fill, linetype, size 

a + geom_ribbon(aes(ymin = unemploy - 900, 
ymax = unemploy + 900)) - x, ymax, ymin,  
alpha, color, fill, group, linetype, size

+ =

To display values, map variables in the data to visual 
properties of the geom (aesthetics) like size, color, and x 
and y locations.

+ =

data geom 
x = F · y = A

coordinate 
system

plot

data geom 
x = F · y = A 
color = F 
size = A

coordinate 
system

plot

Complete the template below to build a graph.
required

ggplot(data = mpg, aes(x = cty, y = hwy)) Begins a plot 
that you finish by adding layers to. Add one geom 
function per layer.      

last_plot() Returns the last plot. 

ggsave("plot.png", width = 5, height = 5) Saves last plot 
as 5’ x 5’ file named "plot.png" in working directory. 
Matches file type to file extension.

F M A

F M A

LINE SEGMENTS 
common aesthetics: x, y, alpha, color, linetype, size

b + geom_abline(aes(intercept = 0, slope = 1)) 
b + geom_hline(aes(yintercept = lat)) 
b + geom_vline(aes(xintercept = long))

b + geom_segment(aes(yend = lat + 1, xend = long + 1)) 
b + geom_spoke(aes(angle = 1:1155, radius = 1))

a <- ggplot(economics, aes(date, unemploy)) 
b <- ggplot(seals, aes(x = long, y = lat))

ONE VARIABLE    continuous
c <- ggplot(mpg, aes(hwy)); c2 <- ggplot(mpg)

c + geom_area(stat = "bin") 
x, y, alpha, color, fill, linetype, size 

c + geom_density(kernel = "gaussian") 
x, y, alpha, color, fill, group, linetype, size, weight 

c + geom_dotplot() 
x, y, alpha, color, fill 

c + geom_freqpoly()  
x, y, alpha, color, group, linetype, size 

c + geom_histogram(binwidth = 5)  
x, y, alpha, color, fill, linetype, size, weight 

c2 + geom_qq(aes(sample = hwy))  
x, y, alpha, color, fill, linetype, size, weight

discrete 
d <- ggplot(mpg, aes(fl))

d + geom_bar()  
x, alpha, color, fill, linetype, size, weight

e + geom_label(aes(label = cty), nudge_x = 1, 
nudge_y = 1) - x, y, label, alpha, angle, color, 
family, fontface, hjust, lineheight, size, vjust 

e + geom_point()  
x, y, alpha, color, fill, shape, size, stroke 

e + geom_quantile()  
x, y, alpha, color, group, linetype, size, weight 

e + geom_rug(sides = “bl")  
x, y, alpha, color, linetype, size 

e + geom_smooth(method = lm)  
x, y, alpha, color, fill, group, linetype, size, weight 

e + geom_text(aes(label = cty), nudge_x = 1, 
nudge_y = 1) - x, y, label, alpha, angle, color, 
family, fontface, hjust, lineheight, size, vjust

one discrete, one continuous 
f <- ggplot(mpg, aes(class, hwy))

f + geom_col()  
x, y, alpha, color, fill, group, linetype, size 

f + geom_boxplot()  
x, y, lower, middle, upper, ymax, ymin, alpha, 
color, fill, group, linetype, shape, size, weight 

f + geom_dotplot(binaxis = "y", stackdir = “center") 
x, y, alpha, color, fill, group 

f + geom_violin(scale = “area")  
x, y, alpha, color, fill, group, linetype, size, weight

both discrete 
g <- ggplot(diamonds, aes(cut, color))

g + geom_count()  
x, y, alpha, color, fill, shape, size, stroke 

e + geom_jitter(height = 2, width = 2) 
x, y, alpha, color, fill, shape, size

THREE VARIABLES 
seals$z <- with(seals, sqrt(delta_long^2 + delta_lat^2)); l <- ggplot(seals, aes(long, lat))

l + geom_raster(aes(fill = z), hjust = 0.5,
vjust = 0.5, interpolate = FALSE)
x, y, alpha, fill

l + geom_tile(aes(fill = z))
x, y, alpha, color, fill, linetype, size, width

h + geom_bin2d(binwidth = c(0.25, 500)) 
x, y, alpha, color, fill, linetype, size, weight 

h + geom_density_2d() 
x, y, alpha, color, group, linetype, size 

h + geom_hex() 
x, y, alpha, color, fill, size

continuous function 
i <- ggplot(economics, aes(date, unemploy))

visualizing error 
df <- data.frame(grp = c("A", "B"), fit = 4:5, se = 1:2) 
j <- ggplot(df, aes(grp, fit, ymin = fit - se, ymax = fit + se))

maps 
data <- data.frame(murder = USArrests$Murder, 
               state = tolower(rownames(USArrests))) 
map <- map_data("state") 
k <- ggplot(data, aes(fill = murder))

k + geom_map(aes(map_id = state), map = map) 
+ expand_limits(x = map$long, y = map$lat)

 map_id, alpha, color, fill, linetype, size

Not  
required, 
sensible 
defaults 
supplied

Geoms Use a geom function to represent data points, use the geom’s aesthetic properties to represent variables.
Each function returns a layer.

TWO VARIABLES 
both continuous 
e <- ggplot(mpg, aes(cty, hwy))

continuous bivariate distribution 
h <- ggplot(diamonds, aes(carat, price))

RStudio® is a trademark of RStudio, PBC  •  CC BY SA  RStudio  •  info@rstudio.com  •  844-448-1212  •  rstudio.com  •  Learn more at ggplot2.tidyverse.org  •  ggplot2  3.3.5  •  Updated:  2021-08

ggplot (data =  <DATA> ) + 
  <GEOM_FUNCTION> (mapping = aes( <MAPPINGS> ), 
  stat = <STAT> , position = <POSITION> ) +     
  <COORDINATE_FUNCTION>  + 
  <FACET_FUNCTION>  + 
  <SCALE_FUNCTION>  + 
  <THEME_FUNCTION>

l + geom_contour(aes(z = z))
x, y, z, alpha, color, group, linetype, size, weight

l + geom_contour_filled(aes(fill = z))
x, y, alpha, color, fill, group, linetype, size, subgroup

i + geom_area() 
x, y, alpha, color, fill, linetype, size 

i + geom_line() 
x, y, alpha, color, group, linetype, size 

i + geom_step(direction = "hv") 
x, y, alpha, color, group, linetype, size

j + geom_crossbar(fatten = 2) - x, y, ymax,  
ymin, alpha, color, fill, group, linetype, size 

j + geom_errorbar() - x, ymax, ymin,  
alpha, color, group, linetype, size, width 
Also geom_errorbarh(). 

j + geom_linerange() 
x, ymin, ymax, alpha, color, group, linetype, size 

j + geom_pointrange() - x, y, ymin, ymax,  
alpha, color, fill, group, linetype, shape, size

Aes
color and fill - string ("red", "#RRGGBB") 
linetype - integer or string (0 = "blank", 1 = "solid",  
2 = "dashed", 3 = "dotted", 4 = "dotdash", 5 = "longdash", 
6 = "twodash") 
lineend - string ("round", "butt", or "square") 
linejoin - string ("round", "mitre", or "bevel") 
size - integer (line width in mm) 
shape - integer/shape name or  
                 a single character ("a")

Common aesthetic values.
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Scales Coordinate Systems
A stat builds new variables to plot (e.g., count, prop). 

Stats  An alternative way to build a layer.

+ =
data geom 

x = x · 
y = ..count..

coordinate 
system

plot

fl cty cyl
x ..count..

stat

Visualize a stat by changing the default stat of a geom 
function, geom_bar(stat="count") or by using a stat 
function, stat_count(geom="bar"), which calls a default 
geom to make a layer (equivalent to a geom function). 
Use ..name.. syntax to map stat variables to aesthetics.

i + stat_density_2d(aes(fill = ..level..), 
geom = "polygon")

stat function geommappings

variable created by stat

geom to use

c + stat_bin(binwidth = 1, boundary = 10) 
x, y |  ..count.., ..ncount.., ..density.., ..ndensity.. 
c + stat_count(width = 1)  x, y |  ..count.., ..prop.. 
c + stat_density(adjust = 1, kernel = "gaussian")  
x, y |  ..count.., ..density.., ..scaled.. 

e + stat_bin_2d(bins = 30, drop = T) 
x, y, fill |  ..count.., ..density.. 
e + stat_bin_hex(bins = 30) x, y, fill |  ..count.., ..density.. 
e + stat_density_2d(contour = TRUE, n = 100) 
x, y, color, size |  ..level.. 
e + stat_ellipse(level = 0.95, segments = 51, type = "t") 

l + stat_contour(aes(z = z)) x, y, z, order |  ..level..
l + stat_summary_hex(aes(z = z), bins = 30, fun = max)
x, y, z, fill |  ..value..
l + stat_summary_2d(aes(z = z), bins = 30, fun = mean)
x, y, z, fill |  ..value..

f + stat_boxplot(coef = 1.5)  
x, y |  ..lower.., ..middle.., ..upper.., ..width.. , ..ymin.., ..ymax.. 
f + stat_ydensity(kernel = "gaussian", scale = "area") x, y 
| ..density.., ..scaled.., ..count.., ..n.., ..violinwidth.., ..width.. 

e + stat_ecdf(n = 40)  x, y |  ..x.., ..y.. 
e + stat_quantile(quantiles = c(0.1, 0.9),  
formula = y ~ log(x), method = "rq")  x, y | ..quantile.. 
e + stat_smooth(method = "lm", formula = y ~ x, se = T,  
level = 0.95) x, y | ..se.., ..x.., ..y.., ..ymin.., ..ymax.. 

ggplot() + xlim(-5, 5) + stat_function(fun = dnorm,  
n = 20, geom = “point”) x |  ..x.., ..y.. 
ggplot() + stat_qq(aes(sample = 1:100))  
x, y, sample |  ..sample.., ..theoretical.. 
e + stat_sum() x, y, size |  ..n.., ..prop.. 
e + stat_summary(fun.data = "mean_cl_boot") 
h + stat_summary_bin(fun = "mean", geom = "bar") 
e + stat_identity() 
e + stat_unique()

Scales map data values to the visual values of an 
aesthetic. To change a mapping, add a new scale.

n <- d + geom_bar(aes(fill = fl))

n + scale_fill_manual( 
     values = c("skyblue", "royalblue", "blue", "navy"), 
     limits = c("d", "e", "p", "r"), breaks =c("d", "e", "p", “r"), 
     name = "fuel", labels = c("D", "E", "P", "R"))

scale_
aesthetic 
to adjust

prepackaged 
scale to use

scale-specific 
arguments

title to use in 
legend/axis

labels to use 
in legend/axis

breaks to use in 
legend/axis

range of 
values to include 

in mapping

GENERAL PURPOSE SCALES 
Use with most aesthetics 
scale_*_continuous() - Map cont’ values to visual ones. 
scale_*_discrete() - Map discrete values to visual ones. 
scale_*_binned() - Map continuous values to discrete bins. 
scale_*_identity() - Use data values as visual ones. 
scale_*_manual(values = c()) - Map discrete values to 
manually chosen visual ones. 
scale_*_date(date_labels = "%m/%d"),  
date_breaks = "2 weeks") - Treat data values as dates. 
scale_*_datetime() -  Treat data values as date times.  
Same as scale_*_date(). See ?strptime for label formats.

X & Y LOCATION SCALES 
Use with x or y aesthetics (x shown here) 
scale_x_log10() - Plot x on log10 scale. 
scale_x_reverse() - Reverse the direction of the x axis. 
scale_x_sqrt() - Plot x on square root scale.

COLOR AND FILL SCALES (DISCRETE) 
n + scale_fill_brewer(palette = "Blues") 
For palette choices: 
RColorBrewer::display.brewer.all() 
n + scale_fill_grey(start = 0.2, 
end = 0.8, na.value = "red") 

COLOR AND FILL SCALES (CONTINUOUS) 
o <- c + geom_dotplot(aes(fill = ..x..))

o + scale_fill_distiller(palette = “Blues”)

o + scale_fill_gradient(low="red", high=“yellow")

o + scale_fill_gradient2(low = "red", high = “blue”,
mid = "white", midpoint = 25)

o + scale_fill_gradientn(colors = topo.colors(6))
Also: rainbow(), heat.colors(), terrain.colors(),
cm.colors(), RColorBrewer::brewer.pal()

SHAPE AND SIZE SCALES 
p <- e + geom_point(aes(shape = fl, size = cyl)) 

p + scale_shape() + scale_size() 
p + scale_shape_manual(values = c(3:7)) 

p + scale_radius(range = c(1,6)) 
p + scale_size_area(max_size = 6)

r <- d + geom_bar() 
r + coord_cartesian(xlim = c(0, 5)) - xlim, ylim 
The default cartesian coordinate system. 

r + coord_fixed(ratio = 1/2)  
ratio, xlim, ylim - Cartesian coordinates with 
fixed aspect ratio between x and y units. 

ggplot(mpg, aes(y = fl)) + geom_bar() 
Flip cartesian coordinates by switching 
x and y aesthetic mappings.  

r + coord_polar(theta = "x", direction=1)  
theta, start, direction - Polar coordinates. 

r + coord_trans(y = “sqrt") - x, y, xlim, ylim 
Transformed cartesian coordinates. Set xtrans 
and ytrans to the name of a window function. 

π + coord_quickmap() 
π + coord_map(projection = "ortho", orientation 
= c(41, -74, 0)) - projection,  xlim, ylim 
Map projections from the mapproj package 
(mercator (default), azequalarea, lagrange, etc.).

Position Adjustments
Position adjustments determine how to arrange geoms 
that would otherwise occupy the same space. 

s <- ggplot(mpg, aes(fl, fill = drv)) 

s + geom_bar(position = "dodge") 
Arrange elements side by side. 
s + geom_bar(position = "fill") 
Stack elements on top of one  
another, normalize height. 

e + geom_point(position = "jitter") 
Add random noise to X and Y position of 
each element to avoid overplotting. 

e + geom_label(position = "nudge") 
Nudge labels away from points. 

s + geom_bar(position = "stack") 
Stack elements on top of one another. 

Each position adjustment can be recast as a function 
with manual width and height arguments: 
s + geom_bar(position = position_dodge(width = 1))

A
B

Themes
r + theme_bw() 
White background 
with grid lines. 

r + theme_gray() 
Grey background  
(default theme). 

r + theme_dark() 
Dark for contrast.

r + theme_classic() 
r + theme_light() 
r + theme_linedraw() 
r + theme_minimal() 
Minimal theme. 

r + theme_void() 
Empty theme.

Faceting
Facets divide a plot into 
subplots based on the  
values of one or more  
discrete variables. 

t <- ggplot(mpg, aes(cty, hwy)) + geom_point() 

t + facet_grid(cols = vars(fl)) 
Facet into columns based on fl. 

t + facet_grid(rows = vars(year)) 
Facet into rows based on year. 

t + facet_grid(rows = vars(year), cols = vars(fl)) 
Facet into both rows and columns. 

t + facet_wrap(vars(fl)) 
Wrap facets into a rectangular layout. 

Set scales to let axis limits vary across facets. 

t + facet_grid(rows = vars(drv), cols = vars(fl), 
scales = "free") 

       x and y axis limits adjust to individual facets: 
                  "free_x" - x axis limits adjust 
                  "free_y" - y axis limits adjust 

Set labeller to adjust facet label: 

t + facet_grid(cols = vars(fl), labeller = label_both) 

t + facet_grid(rows = vars(fl), 
labeller = label_bquote(alpha ^ .(fl)))

fl: c fl: d fl: e fl: p fl: r

↵c ↵d ↵e ↵p ↵r

Labels and Legends
Use labs() to label the elements of your plot. 
t + labs(x = "New x axis label",  y = "New y axis label", 
     title ="Add a title above the plot",  
     subtitle = "Add a subtitle below title", 
     caption = "Add a caption below plot", 
     alt = "Add alt text to the plot", 
         <aes>  = "New   <aes>    legend title") 

t + annotate(geom = "text", x = 8, y = 9, label = “A") 
Places a geom with manually selected aesthetics. 
p + guides(x = guide_axis(n.dodge = 2)) Avoid crowded 
or overlapping labels with guide_axis(n.dodge or angle). 
n + guides(fill = “none") Set legend type for each 
aesthetic: colorbar, legend, or none (no legend). 
n + theme(legend.position = "bottom") 
Place legend at "bottom", "top", "left", or “right”. 
n + scale_fill_discrete(name = "Title",  
labels = c("A", "B", "C", "D", "E"))  
Set legend title and labels with a scale function.

<AES> <AES>

Zooming
Without clipping (preferred): 
t + coord_cartesian(xlim = c(0, 100), ylim = c(10, 20)) 
With clipping (removes unseen data points): 
t + xlim(0, 100) + ylim(10, 20) 
t + scale_x_continuous(limits = c(0, 100)) + 
scale_y_continuous(limits = c(0, 100))

RStudio® is a trademark of RStudio, PBC  •  CC BY SA  RStudio  •  info@rstudio.com  •  844-448-1212  •  rstudio.com  •  Learn more at ggplot2.tidyverse.org  •  ggplot2  3.3.5  •  Updated:  2021-08
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long

la
t

r + theme() Customize aspects of the theme such  
as axis, legend, panel, and facet properties. 
r + ggtitle(“Title”) + theme(plot.title.postion = “plot”) 
r + theme(panel.background = element_rect(fill = “blue”))  

Override defaults with scales package.
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dev.size() (width, height) 
par("din") (r.o.) (width, height) in inches

Both the dev.size function and the din
argument of par will tell you the size of the 
graphics device. The dev.size function will 
report the size in

1. inches (units="in"), the default
2. centimeters (units="cm")
3. pixels (units="px")

Like several other par arguments, din is 
read only (r.o.) meaning that you can ask 
its current value (par("din")) but you 
cannot change it (par(din=c(5,7)) will fail).

How Big is Your 
Graph?

An R Cheat Sheet
Introduction

CC BY Steve Simon, P.Mean Consulting  •  mail@pmean.com  • https://www.rstudio.com/resources/cheatsheets/ Learn more at blog.pmean.com/cheatsheets •  Updated: August 2017

Your plot margins

par("mai") (bottom, left, top, right) in inches
par("mar") (bottom, left, top, right) in lines

Margins provide you space for your axes, axis, 
labels, and titles.

A "line" is the amount of vertical space needed 
for a line of text. 

If your graph has no axes or titles, you can 
remove the margins (and maximize the 
plotting region) with

par(mar=rep(0,4))

Your graphics device

All functions that open a device for graphics 
will have height and width arguments to 
control the size of the graph and a 
pointsize argument to control the relative 
font size. In knitr, you control the size of 
the graph with the chunk options, fig.width
and fig.height. This sheet will help you with 
calculating the size of the graph and 
various parts of the graph within R.

Your x-y coordinates

par("usr") (xmin, ymin, xmax, ymax)

Your x-y coordinates are the values you use 
when plotting your data. This normally is not 
the same as the values you specified with the 
xlim and ylim arguments in plot. By default, R 
adds an extra 4% to the plotting range (see 
the dark green region on the figure) so that 
points right up on the edges of your plot do 
not get partially clipped. You can override 
this by setting xaxs="i" and/or the yaxs="i" in 
par.

Run par("usr") to find the minimum X value, 
the maximum X value, the minimum Y value, 
and the maximum Y value. If you assign new 
values to usr, you will update the x-y 
coordinates to the new values.

Your plotting region

par("pin") (width, height) in inches
par("plt") (left, right, bottom, top) in pct

The pin argument par gives you the size 
of the plotting region (the size of the device 
minus the size of the margins) in inches. 

The plt argument gives you the percentage 
of the device from the left/bottom edge up 
to the left edge of the plotting region, the 
right edge, the bottom edge, and the top 
edge. The first and third values are 
equivalent to the percentage of space 
devoted to the left and bottom margins. 
Subtract the second and fourth values from 
1 to get the percentage of space devoted to 
the right and top margins.

Getting a square graph

par("pty")

You can produce a square graph manually 
by setting the width and height to the same 
value and setting the margins so that the 
sum of the top and bottom margins equal 
the sum of the left and right margins. But a 
much easier way is to specify pty="s", 
which adjusts the margins so that the size 
of the plotting region is always square, even 
if you resize the graphics window.

Converting units

For many applications, you need to be able 
to translate user coordinates to pixels or 
inches. There are some cryptic shortcuts, 
but the simplest way is to get the range in 
user coordinates and measure the 
proportion of the graphics device devoted to 
the plotting region.

user.range <- par("usr")[c(2,4)] -
par("usr")[c(1,3)]

region.pct <- par("plt")[c(2,4)] -
par("plt")[c(1,3)]

region.px <-
dev.size(units="px") * region.pct

px.per.xy <- region.px / user.range

To convert a horizontal or distance from the 
x-coordinate value to pixels, multiply by
px.per.xy[1]. To convert a vertical distance,
multiply by region.px.per.xy[2]. To convert
a diagonal distance, you need to invoke
Pyhthagoras.

a.px <- x.dist*px.per.xy[1]
b.px <- y.dist*px.per.xy[2]
c.px <- sqrt(a.px^2+b.px^2)

To rotate a string to match the slope of a line 
segment, you need to convert the distances 
to pixels, calculate the arctangent, and 
convert from radians to degrees.

segments(x0, y0, x1, y1)
delta.x <- (x1 – x0) * px.per.xy[1]
delta.y <- (y1 – y0) * px.per.xy[y]
angle.radians <- atan2(delta.y, delta.x)
angle.degrees <- angle.radians * 180 / pi
text(x1, y1, "TEXT", srt=angle.degrees)
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If your fonts are too big or too small

par("cin") (r.o.) (width, height) in inches
par("csi") (r.o.) height in inches
par("cra") (r.o.) (width, height) in pixels
par("cxy") (r.o.) (width, height) in xy
coordinates

The single value returned by the csi
argument of par gives you the height of a 
line of text in inches. The second of the two 
values returned by cin, cra, and cxy gives 
you the height of a line, in inches, pixels, or 
xy (user) coordinates.

The first of the two values returned by the 
cin, cra, and cxy arguments to par gives 
you the approximate width of a single 
character, in inches, pixels, or xy (user) 
coordinates. The width, very slightly smaller 
than the actual width of the letter "W", is a 
rough estimate at best and ignores the 
variable with of individual letters.

These values are useful, however, in 
providing fast ratios of the relative sizes of 
the differing units of measure

px.per.in <- par("cra") / par("cin")
px.per.xy <- par("cra") / par("cxy")
xy.per.in <- par("cxy") / par("cin")

Character and string sizes

strheight()

The strheight functions will tell you the height 
of a specified string in inches 
(units="inches"), x-y user coordinates 
(units="user") or as a percentage of the 
graphics device (units="figure").

For a single line of text, strheight will give you 
the height of the letter "M". If you have a string 
with one of more linebreaks ("\n"), the 
strheight function will measure the height of 
the letter "M" plus the height of one or more 
additional lines. The height of a line is 
dependent on the line spacing, set by the 
lheight argument of par. The default line 
height (lheight=1), corresponding to single 
spaced lines, produces a line height roughly 
1.5 times the height of "M".

strwidth()

The strwidth function will produce different 
widths to individual characters, representing 
the proportional spacing used by most fonts (a 
"W" using much more space than an "i"). For 
the width of a string, the strwidth function will 
sum up the lengths of the individual characters 
in the string.

par("fig") (width, height) in pct
par("fin") (width, height) in inches

If you display multiple plots within a single 
graphics window (e.g., with the mfrow
or mfcol arguments of par or with the layout 
function), then the fig and fin arguments will 
tell you the size of the current subplot window 
in percent or inches, respectively.

par("oma") (bottom, left, top, right) in lines
par("omd") (bottom, left, top, right) in pct
par("omi") (bottom, left, top, right) in inches

Each subplot will have margins specified 
by mai or mar, but no outer margin around the 
entire set of plots, unless you specify them 
using oma, omd, or omi. You can place text 
in the outer margins using the mtext function 
with the argument outer=TRUE.

par("mfg") (r, c) or (r, c, maxr, maxc)

The mfg argument of par will allow you to 
jump to a subplot in a particular row and 
column. If you query with par("mfg"), you will 
get the current row and column followed by 
the maximum row and column.

If your axes don’t fit

There are several possible solutions.

1. You can assign wider margins using the
mar or mai argument in par.

2. You can change the orientation of the
axis labels with las. Choose among

a. las=0 both axis labels parallel
b. las=1 both axis labels horizontal
c. las=2 both axis labels perpendicular
d. las=3 both axis labels vertical.

Fixing this takes a bit of trial and error.

1. Specify a larger/smaller value for the
pointsize argument when you open your
graphics device.

2. Trying opening your graphics device with
different values for height and width. Fonts
that look too big might be better
proportioned in a larger graphics window.

3. Use the cex argument to increase or
decrease the relative size of your fonts.

3. change the relative size of the font
a. cex.axis for the tick mark labels.
b. cex.lab for xlab and ylab.
c. cex.main for the main title
d. cex.sub for the subtitle.

Panels

22

mailto:mail@pmean.com
https://www.rstudio.com/resources/cheatsheets/


SUMMARY STATISTICS: 
one continuous variable:  
mosaic::mean(~mpg, data=mtcars) 

one categorical variable: 
mosaic::tally(~cyl, data=mtcars) 

two categorical variables: 
mosaic::tally(cyl~am, data=mtcars) 

one continuous, one categorical:  
mosaic::mean(mpg~cyl, data=mtcars) 

SUMMARY STATISTICS:  
 

one continuous variable:  
mean(mtcars$mpg) 

one categorical variable: 
table(mtcars$cyl) 

two categorical variables: 
table(mtcars$cyl, mtcars$am) 

one continuous, one categorical: 
mean(mtcars$mpg[mtcars$cyl==4]) 
mean(mtcars$mpg[mtcars$cyl==6]) 
mean(mtcars$mpg[mtcars$cyl==8]) 

PLOTTING: 
one continuous variable: 

hist(mtcars$disp) 

boxplot(mtcars$disp)

one categorical variable: 
barplot(table(mtcars$cyl)) 

two continuous variables: 
plot(mtcars$disp, mtcars$mpg) 

two categorical variables: 
mosaicplot(table(mtcars$am, mtcars$cyl)) 

one continuous, one categorical: 
histogram(mtcars$disp[mtcars$cyl==4]) 
histogram(mtcars$disp[mtcars$cyl==6]) 
histogram(mtcars$disp[mtcars$cyl==8]) 

boxplot(mtcars$disp[mtcars$cyl==4]) 
boxplot(mtcars$disp[mtcars$cyl==6]) 
boxplot(mtcars$disp[mtcars$cyl==8])

WRANGLING: 
subsetting: 

mtcars[mtcars$mpg>30, ] 

making a new variable: 
mtcars$efficient[mtcars$mpg>30] <- TRUE 
mtcars$efficient[mtcars$mpg<30] <- FALSE

R Syntax Comparison : : CHEAT SHEET 

RStudio® is a trademark of RStudio, Inc.CC BY         Amelia McNamara •  amcnamara@smith.edu  •  @AmeliaMN • science.smith.edu/~amcnamara/  •  Updated: 2018-01

Dollar sign syntax

tilde

Formula syntax Tidyverse syntax
goal(data$x, data$y) goal(y~x|z, data=data, group=w) data %>% goal(x)

PLOTTING: 
one continuous variable: 
lattice::histogram(~disp, data=mtcars) 

lattice::bwplot(~disp, data=mtcars) 

one categorical variable: 
mosaic::bargraph(~cyl, data=mtcars) 

two continuous variables: 
lattice::xyplot(mpg~disp, data=mtcars) 

two categorical variables: 
mosaic::bargraph(~am, data=mtcars, group=cyl) 

one continuous, one categorical: 
lattice::histogram(~disp|cyl, data=mtcars) 

lattice::bwplot(cyl~disp, data=mtcars) 

SUMMARY STATISTICS: 
one continuous variable: 

mtcars %>% dplyr::summarize(mean(mpg)) 

one categorical variable: 
mtcars %>% dplyr::group_by(cyl) %>% 
dplyr::summarize(n()) 

two categorical variables: 
mtcars %>% dplyr::group_by(cyl, am) %>% 
dplyr::summarize(n()) 

one continuous, one categorical: 
mtcars %>%  dplyr::group_by(cyl) %>% 

dplyr::summarize(mean(mpg))

PLOTTING: 
one continuous variable: 
ggplot2::qplot(x=mpg, data=mtcars, geom = "histogram") 

ggplot2::qplot(y=disp, x=1, data=mtcars, geom="boxplot") 

one categorical variable: 
ggplot2::qplot(x=cyl, data=mtcars, geom="bar") 

two continuous variables: 
ggplot2::qplot(x=disp, y=mpg, data=mtcars, geom="point") 

two categorical variables: 
ggplot2::qplot(x=factor(cyl), data=mtcars, geom="bar") + 

facet_grid(.~am) 

one continuous, one categorical: 
ggplot2::qplot(x=disp, data=mtcars, geom = "histogram") + 

facet_grid(.~cyl) 

ggplot2::qplot(y=disp, x=factor(cyl), data=mtcars,  
geom="boxplot") 

WRANGLING: 
subsetting: 
mtcars %>% dplyr::filter(mpg>30) 

making a new variable: 
mtcars <- mtcars %>%  
dplyr::mutate(efficient = if_else(mpg>30,  TRUE, FALSE))

the pipe

The variety of R syntaxes give 
you many ways to “say” the 
same thing

read across the cheatsheet to see how different 
syntaxes approach the same problem
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R Syntax Comparison : : CHEAT SHEET 
Even within one syntax, there are often variations that are equally valid. As a case study, let’s look at the ggplot2 
syntax. ggplot2 is the plotting  package that lives within the tidyverse. If you read down this column, all the code 
here produces the same graphic.

quickplot

ggplot

ggplot2::qplot(x=disp, y=mpg, data=mtcars, geom="point") 

ggplot2::ggplot(mtcars) +  
    geom_point(aes(x=disp, y=mpg))

ggplot2::ggplot(mtcars, aes(x=disp, y=mpg)) +  
    geom_point()

ggplot2::ggplot(mtcars, aes(x=disp)) +  
    geom_point(aes(y=mpg))

ggplot2::qplot(x=disp, y=mpg, data=mtcars) 

ggplot2::qplot(disp, mpg, data=mtcars) !

! Sometimes particular syntaxes work, but are considered 
dangerous to use, because they are so easy to get wrong. For 
example, passing variable names without assigning them to a 
named argument.

qplot() stands for quickplot, and allows you to make quick plots. It doesn’t have the full power of ggplot2, 
and it uses a slightly different syntax than the rest of the package. 

To unlock the power of ggplot2, you need to use the ggplot() function (which sets up a plotting region) and 
add geoms to the plot. 

!

!

Syntax is the set of rules that govern what code works and
doesn’t work in a programming language. Most programming 
languages offer one standardized syntax, but R allows package 
developers to specify their own syntax. As a result, there is a large 
variety of (equally valid) R syntaxes.  

The three most prevalent R syntaxes are:  
1. The dollar sign syntax, sometimes called base R

syntax, expected by most base R functions. It is
characterized by the use of dataset$variablename, and
is also associated with square bracket subsetting, as in
dataset[1,2]. Almost all R functions will accept things
passed to them in dollar sign syntax.

2. The formula syntax, used by modeling functions like
lm(), lattice graphics, and mosaic summary statistics. It
uses the tilde (~) to connect a response variable and one (or
many) predictors. Many base R functions will accept formula
syntax.

3. The tidyverse syntax used by dplyr, tidyr, and
more. These functions expect data to be the first argument,
which allows them to work with the “pipe” (%>%) from the
magrittr package. Typically, ggplot2 is thought of as part
of the tidyverse, although it has its own flavor of the syntax
using plus signs (+) to string pieces together. ggplot2 author
Hadley Wickham has said the package would have had
different syntax if he had written it after learning about the
pipe.

Educators often try to teach within one unified syntax, but most R 
programmers use some combination of all the syntaxes.

Even more ways to say the same thing

RStudio® is a trademark of RStudio, Inc.  •  CC BY Amelia McNamara •  amcnamara@smith.edu  •  @AmeliaMN • science.smith.edu/~amcnamara/  •  Updated: 2018-01

read dow
n this colum

n for m
any pieces of code in one  

syntax that look different but  produce the sam
e graphic

ggformula

ggformula::gf_point(mpg~disp, data= mtcars)

The “third and a half way” to use the formula syntax, but get ggplot2-style graphics

Internet research tip:
If you are searching on google, StackOverflow, or 
another favorite online source and see code in a syntax 
you don’t recognize: 
• Check to  see if the code is using one of the three

common syntaxes listed on this cheatsheet
• Try your search again, using a keyword from the

syntax name (“tidyverse”) or a relevant package
(“mosaic”)

ggplot2::ggplot(data=mtcars) +  
    geom_point(mapping=aes(x=disp, y=mpg))

formulas in base plots
plot(mpg~disp, data=mtcars)
Base R plots will also take the formula syntax, although it's not as commonly used

plus adds 
layers
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Basics

Tabular reporting with flextable : : CHEAT SHEET

ArData. • ardata.fr •  Learn more at ardata-fr.github.io/flextable-book/ •  package version  0.6.4 •  Updated: 2021-03

Format

Layout

Officer

ICONS

The flextable package provides a framework 
for easily create tables for reporting and 
publications. 
Functions are provided to let users create 
tables, modify, format and define their 
content.

data.frame flextable

flextable()

TABLE PARTS AND THEIRS DEFAULT VALUES
header : colnames

body : data

footer : empty

Selectors

GENERAL

get_flextable_defaults() : get flextable defaults 
formatting properties
set_flextable_defaults() :  modify flextable
defaults formatting properties
init_flextable_defaults() :  re-init all values 
with the package defaults
style(pr_t, pr_p, pr_c) : modify flextable text, 
paragraphs and cells formatting properties 
(needs officer package)

pr_t: object of class fp_text
pr_p object of class fp_par
pr_c: object of class fp_cell

TEXT

CELL

ft <- flextable(data)

Abc font(ft, fontname = "Brush Script MT")
Abc fontsize(ft, size = 7)
Abc italic(ft, italic = TRUE)
Abc bold(ft, bold = TRUE)
Abc color(ft, color = "#eb5555")
Abc highlight(ft, color = "yellow")

Abc rotate(ft, rotation = "tbrl")

Abc align(ft, align = "center")
Abc valign(ft, valign = "top")

Abc padding(ft,  padding = 10)

Abc bg(ft, bg = "#475f77")

Abc line_spacing(ft,  space = 1.6)
i: row selector
j: column selector

brdr <- fp_border(color = "#eb5555", width = 1.5)

border_outer(ft, border = brdr)

border_inner(ft, border = brdr)

border_inner_v(ft, border = brdr)

border_inner_h(ft, border = brdr)

border_remove(ft)

vline_left(ft, border  = brdr)

vline_right(ft, border  = brdr)

hline_top(ft, border  = brdr)

hline_bottom(ft, border  = brdr)

vline(ft, j=1:2, border = brdr)

merge_none(ft)

BORDER

tron(ft)

zebra(ft)

FORMULA

COLWIDTHS

INTEGER VECTOR

LOGICAL VECTOR

i = ~ col %in% "xxx" 
col : column name
xxx : value
j = ~ col1 + col2 
col* : column name

function(x, i, j, part, args)

flextable object

row & column
selectors

flextable part

specific
arguments

j = c("col1", "col2")
col* : column name

all

i = 1:3, j = 1:3

i = c(TRUE, FALSE) , j = c(TRUE, FALSE) 

GENERAL FUNCTION’S STRUCTURE

THEME

alafoli(ft) booktabs(ft) box(ft)

vader(ft)tron_legacy(ft) vanilla(ft)

ft <- theme_*(ft)

fp_text() : Text formatting properties
color, font.size, bold, italic, underlined, font.family, 
vertical.align, shading.color
fp_par() :  Paragraph formatting properties
text.align, padding, line_spacing, border, 
shading.color, padding.bottom, padding.top, 
padding.left, padding.right, border.bottom, 
border.left, border.top, border.right
fp_cell() :  Cell formatting properties
border, border.bottom, border.left, border.top, 
border.right, vertical.align, margin, margin.bottom, 
margin.top, margin.left, margin.right, 
background.color, text.direction
fp_border():  border properties object
color, style, width
update(x, args):  update an object of class fp_*

HEADER AND FOOTER
CELL MERGING

CAPTIONS & FOOTNOTES

add_header_row(ft, values = c("a", 
"b", "c"),  colwidths = c(1, 1, 1), top = 
FALSE)
add_footer_row(ft, values = c("", "", 
"),  colwidths = c(1, 1, 1))

add_header_lines(ft, values = "line", 
top = FALSE)

add_footer_lines(ft, values = "line")

CHARACTER VECTOR

IN LINE

COLNAME
add_header(ft, A = "a", B = "b", top = 
FALSE)

add_footer(ft, A = "" , B = "")

add_body(ft, A = "a", B = "b", C = "")

GENERAL
set_header_labels(ft, A = "Aaa", B = 
"Bbb", C = "Ccc")
delete_part( ft, part =  "body")

set_caption(ft, caption = "my 
caption“)

footnote(ft, j = 1,  value = 
as_paragraph(c("footnote 1")),
ref_symbols = c("1"),  part = 
"header")

hline(ft, i = 1:2, border = brdr)

1, 2, 3, 4

1: merge_at(ft, i = 1:2, j = 1:2)
2: merge_h(ft)
3: merge_v(ft)
4: merge_h_range(ft, i = ~ C %in% "0", j1 = 
"A", j2 = "B")
fix_border_issues(ft): fix border issues when 
cell are merged
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Table size
ft <- flextable(data)

Tabular reporting with flextable : : CHEAT SHEET

Cell content

Rendering

flextable_dim(ft): 
$widths
[1] 2.25
$heights
[1] 1.75
$aspect_ratio
[1] 0.78

widths

nrow_part(ft, 
part = "body"): 
6

ncol_keys(ft): 3

he
ig

ht
s

dim(ft): 
$widths
A    B    C 
0.75 0.75 0.75 
$heights
[1] 0.25 0.25 0.25
0.25 0.25 0.25 0.25

width: 0.75

height: 0.25

dim_pretty(ft): 
$widths
[1] 0.22 0.22 0.22
$heights
[1] 0.22 0.22 0.22 0.22 0.22 0.22 0.22

autofit(ft, add_w = w, add_h = h) 

width(ft, i = 1, width = 0.5) 

ft <- height(ft, i = 1, height = 0.40, part = "body")
ft <- height(ft, i = 4, height = 0.30, part = "body")

height: 0.22

width: 0.22
w = 0, h = 0 w = 0.2, h = 0

width: 0.42

flextable default format is HTML output 
printed in the rstudio viewer pane.
flextable objects can be rendered in HTML
format, Microsoft Word, Microsoft 
PowerPoint and PDF.

print(ft, preview = "docx")
print(ft, preview = "pptx") 

save_as_html(ft, "ft.html")
save_as_docx(ft, "ft.docx")
save_as_pptx(ft, "ft.pptx")
save_as_image(ft, "ft.png")

SIMPLE EXPORT

INTERACTIVE SESSION

RMARKDOWN DOCUMENTS
```{r}
library(flextable)
ft <- flextable(ft)
ft
```
LOOPING IN RMARKDOWN WITH FOR
flextable_to_rmd(ft)

WITH OFFICER
ph_with(ppt, value = ft)  (PowerPoint)
ppt : an rpptx object
body_add_flextable(value = ft) (Word)

IN SHINY
library(shiny)
library(flextable)
ft <- flextable(data)
# In UI
uiOutput("ft")

# In server
output$ft <- renderUI({

htmltools_value(ft)
})

SIMPLE FORMATTING

MULTI CONTENT
FUNCTION COMPOSE ft <- flextable(data)

ft <- compose(ft,  value = as_paragraph(
as_chunk("chunk"),
as_bracket("bracket")
as_b("bold"),
as_hithlight("highlight", color = "yellow")
as_i("italic"),
as_sub("sub"),
as_sup("sup"),
colorize("colorize", color = "#eb5555"),
hyperlink_text(hyperlink, url = "http://link"),
as_image(src, width = 0.2, height = 0.2)))

chunk 
(bracket) 
bold
highlight
italic
sub

sup

colorize
hyperlink

Chunk 1 Chunk 2 Image 1

compose(x, i, j, value = …, part, use_dot)

as_paragraph( )

as_chunk(props), 
as_bracket(), 
as_b(), 
as_highlight(), 
as_i(),  

as_sub(), 
as_sup(), 
colorize(), 
hyperlink_text(),
as_image()

use_dot(): by default use_dot=FALSE; if use_dot=TRUE, value is 
evaluated within a data.frame augmented of a column named . 
containing the jth column
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ft <- hrule(ft, rule = "exact", 
part = "header")
height(ft, height = 0.40, part 
= "header")

width: 0.5 width: 0.75

height: 0.4
height: 0.25

ft <- hrule(ft, rule = “auto", part = "header")
ft <- hrule(ft, i = 1, rule = "exact", part = 
"body"): size exactly at 0.4
ft <- hrule(ft, i = 4, rule = "atleast", part = 
"body"): size atleast at 0.3
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